


Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where you may specify the 
range of pages to be printed, the number of copies, the destination printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and printer 
connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the printer.    The page 
number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When you choose this 
command, the main window will be replaced with a print preview window in which one or two pages will be 
displayed in their printed format.    The print preview toolbar offers you options to view either one or two pages at a 
time; move back and forth through the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a Print Setup dialog box, 
where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option and select 
one of the current installed printers shown in the box.    You install printers and configure ports using the 
Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of printer you 
have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



 <<YourApp>> Help Index

How To ...
<<add your application-specific "how to" topics here>>

Commands
File menu
Edit menu
Record menu
View menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

Close Closes an opened document.
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste Link Pastes from the clipboard a link to data in another application.
Insert New 
Object

Inserts and embeds an object, such as a chart or an equation in a document.

Links List and edit links to embedded documents.



View menu commands

The View menu offers the following commands:



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple 
documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Split Split the active window into panes.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
About Displays the version number of this application.



Close command (File menu)

Use this command to close all windows containing the active document.    <<YourApp>> suggests that you save 
changes to your document before you close it.    If you close a document without saving, you lose all changes made 
since the last time you saved it.    Before closing an untitled document, <<YourApp>> displays the Save As dialog 
box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you closed.    
Choose the number that corresponds with the document you want to open.



Undo/Can't Undo command (Edit menu)

<< Your application's user interface for Undo may differ from the one described below.    Modify this help text 
accordingly. >>

Use this command to reverse the last editing action, if possible.      The name of the command changes, depending on 
what the last action was.    The Undo command changes to Can't Undo on the menu if you cannot reverse your last 
action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

<< Write application-specific help here. >>



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    This 
command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is unavailable if 
the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Status Bar

The status bar is displayed at the bottom of the <<YourApp>> window.    To display or hide the status bar, use the 
Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. 
This area similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing 
them.    If after viewing the description of the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You can open multiple 
document windows to display different parts or views of a document at the same time.    If you change the contents 
in one window, all other windows containing the same document reflect those changes.    When you open a new 
window, it becomes the active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If there is an 
open document window at the bottom of the main window, then some or all of the icons may not be visible because 
they will be underneath this document window.



Split Command (Window menu)

Use this command to split the active window into panes.    You may then use the mouse or the keyboard arrows to 
move the splitter bars.    When you are finished, press the mouse button or return to leave the splitter bars in their 
new location.    Pressing escape keeps the splitter bars in their original location.    << In a single document interface 
application, this command will appear on the View menu. >>



1, 2, ... command (Window menu)

<<YourApp>> displays a list of currently open document windows at the bottom of the Window menu.    A check 
mark appears in front of the document name of the active window.    Choose a document from this list to make its 
window active. 



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to step-by-step 
instructions for using <<YourApp>> and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of <<YourApp>>.



Context Help command 

Use the Context Help command to obtain help on some portion of <<YourApp>>.    When you choose the Toolbar's 
Context Help button, the mouse pointer will change to an arrow and question mark.    Then click somewhere in the 
<<YourApp>> window, such as another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:

Application Control-menu button

Document Control-menu button

Maximize button

Minimize button

Name of the application



Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars indicate 
your vertical and horizontal location in the document.    You can use the mouse to scroll to other parts of the 
document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you 
want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow 
keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the <<YourApp>> window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    <<YourApp>> determines which window is next 
according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    <<YourApp>> determines which window is 
previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document Control 
menu closes only one window at a time.    You can close all windows at once with the Close command on the File 
menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or Minimize 
command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an application 
on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does not affect 
applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect applications reduced 
to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item changes to Can't Repeat 
if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should modify a document using 
your application. 

If your application supports multiple document types and you want to have a distinct help topic for each, then use 
the help context i.d. generated by running the MAKEHELP.BAT file produced by AppWizard.    Alternatively, run 
MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the help context i.d. 
generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the first document type 
supported by your application.    AppWizard produces an alias in the .HPJ file for your application, mapping 
HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for that document type. >>





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx values from 
the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For example, 
AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>
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Copyright/Warranty/Trademark Notices

Warranties and Liabilities 

All warranties given by Intergraph Corporation about equipment or software are set forth in your 
purchase contract, and nothing stated in, or implied by, this document or its contents shall be considered 
or deemed a modification or amendment of such warranties. 

The information and the software discussed in this document are subject to change without notice and 
should not be considered commitments by Intergraph Corporation. Intergraph Corporation assumes no 
responsibility for any error that may appear in this document. 

The software discussed in this document is furnished under a license and may be used or copied only in 
accordance with the terms of this license. 

No responsibility is assumed by Intergraph for the use or reliability of software on equipment that is not 
supplied by Intergraph or its affiliated companies. 

Trademarks 

Intergraph is a registered trademark of Intergraph Corporation.    All other brands and product names are 
trademarks of their respective owners. 

Copyright 

© 1995 Intergraph Corporation 
All Rights Reserved 

Including software, file formats, and audiovisual displays; may be used pursuant to applicable software 
license agreement; contains confidential and proprietary information of Intergraph and/or third parties 
which is protected by copyright and trade secret law and may not be provided or otherwise made 
available without proper authorization. 

RESTRICTED RIGHTS LEGEND 

Use, duplication, or disclosure by the government is subject to restrictions as set forth in subparagraph (c) 
(1) (ii) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c) (1) and (2) of Commercial Computer Software - Restricted Rights at 48 CFR 52.227-
19, as applicable. 

Unpublished - rights reserved under the copyright laws of the United States.

Intergraph Corporation
Huntsville, Alabama 35894-0001



File Menu
New 
Open Submenu 
Save 
Save As Submenu 
Import Submenu 
Export Submenu 
Exit



New
Opens a new Voxel Analyst session.    If there is a session already open, you are prompted to save the 
current session.    A new default empty session is then started. 

TIP         = File > New (or ALT+f,n) 



Open Submenu
Open Session 
Open Dataset 
Open Color File



Open Session
Closes the current session and lets you open an existing session. Session (GVA) files may contain one or 
more datasets, color-table files, and graphic displays. 

TIP         = File > Open > Session (or ALT+f,o,s) 

SEE ALSO 
Open Dialog Box 



Open Dialog Box
Use this dialog box to select a session (GVA) file.    GVA files have a .gva extension, and they can reside 
in any directory, on any drive, or on any network drive/directory. 

File Name    ---    type a GVA file name, or select a file from the list below the File Name text box. 

Directories    ---    double click the directory name that contains the GVA file you want to open; then select 
the GVA file from the list below the File Name text box. 

List Files of Type    ---    displays the GVA file filter (*.gva). 

Drives    ---    select the drive that contains the directory you want, double click the directory name, and 
select the file name from the list. 

Network    ---    opens the Connect to Network dialog box.    Connect as you normally would; then select 
the drive, directory, and GVA file you want. 



Open Dataset
Lets you open an existing Hierarchical Dataset Format (HDF) file. An HDF file is a binary format file, 
which is the primary data type of Voxel Analyst.    See the sample HDF files in the \voxel\samples\misc 
directory. 

TIP        File > Open > Dataset = or ALT+f,o,d 

SEE ALSO 

Open Dialog Box 



Open Dialog Box
Use this dialog box to select an HDF file to open.    HDF files have an .hdf extension, and they can reside 
in any directory, on any drive, or on any network drive/directory. 

File Name    ---    type an HDF file name, or select a file from the list below the File Name text box. 

NOTE        If the selected HDF file has the same name as the current HDF file, the Dataset Conflict dialog 
box appears. 

Directories    ---    double click the directory name that contains the HDF file you want to open; then select 
the file from the list below the File Name text box. 

List Files of Type    ---    displays the HDF file filter (*.hdf). 

Drives    ---    select the drive that contains the directory you want, double click the directory name, and 
select the file name from the list. 

Network    ---    opens the Connect to Network dialog box.    Connect as you normally would; then select 
the drive, directory, and HDF file you want. 



Dataset Conflict Dialog Box
Use this dialog box to resolve conflicts between current datasets that you are opening. 

Existing Dataset    ---    displays the current dataset name. 

New Dataset    ---    displays the current dataset name; type a new name to automatically select the 
Rename New Entry option. 

Replace Existing with New Entry    ---    replaces the current dataset with the new dataset of the same 
name. 

Rename New Entry    ---    renames the dataset to the name in the New Dataset text box. 

Discard New Entry    ---    cancels loading the new dataset and continues loading the current dataset. 



Open Color File
Lets you open a color-table (CTR) file.    A CTR file contains one or more color tables that contain 
surface-material properties, interval values, and colors.    Opening a CTR file makes the color table(s) in 
that file available for use in Voxel Analyst. 

Important        Voxel Analyst color tables are not compatible with MicroStation color tables. 

TIP        File > Open > Color File = ALT+f,o,c 

SEE ALSO 

Open Dialog Box 



Open Dialog Box
Use this dialog box to select a color-table (CTR) file to open.    CTR files have a .ctr extension, and they 
can reside in any directory, on any drive, or on any network drive/directory. 

File Name    ---    type a CTR file name, or select a file name from the list below the File Name text box. 

NOTE        If the selected CTR file contains a color table that has the same name as a current color table, 
the Color Table Conflict dialog box appears. 

Append    ---    adds the color table(s) in the selected file to the current color table (in memory). 

Overwrite    ---    deletes the current color tables from memory before opening the selected file. 

NOTE        When using Voxel Analyst on Window95, the Append and Overwrite options are not available. 
Opening a CTR file automatically appends the current CTR file. 

Directories    ---    double click the directory name that contains the CTR file you want to open; then select 
the file from the list below the File Name text box. 

List Files of Type    ---    displays the CTR file filter (*.ctr). 

Drives    ---    select the drive that contains the directory you want, double click the directory name, and 
select the file name from the list. 

Network    ---    opens the Connect to Network dialog box.    Connect as you normally would; then select 
the drive, directory, and CTR file you want. 



Color Table Conflict Dialog Box
Use this dialog box to resolve conflicts between current color tables and color tables in the CTR file that 
you are opening. 

Existing Color Table    ---    displays the current color table name. 

New Color Table    ---    displays the current color table name; type a new name to automatically select the 
Rename New Entry option. 

Replace Existing with New Entry    ---    replaces the current color table with the new color table of the 
same name. 

Rename New Entry    ---    renames the new color table to the name in the New Color Table text box. 

Discard New Entry    ---    cancels loading the new color table and continues loading the remaining tables 
in the selected CTR file. 

Discard All    ---    discards the new color table in this and all remaining conflicts. 

Replace All    ---    replaces the current color table in this and all remaining conflicts. 



Save
Saves the current Voxel Analyst session. 

TIP         = File > Save (or ALT+f,s) 



Save As Submenu
Save As Session 
Save As Dataset 
Save As Color File



Save As Session
Lets you save the active dataset, graphic displays, color tables, Z scale, and working units information to 
a session (GVA) file. 

TIP        File > Save As > Session = ALT+f,a,s 

SEE ALSO 

Save As Dialog Box 



Save As Dialog Box
Use this dialog box to save the current session to a GVA file.    Session files have a .gva extension, and 
they can be saved to any directory, drive, or network drive/directory. 

NOTE        This dialog box appears automatically when you exit Voxel Analyst without first saving the 
active session. 

File Name    ---    type a new or existing GVA file name, or select a file from the list below the File Name 
text box. 

Directories    ---    double click the directory name that contains the GVA file you want to overwrite or the 
directory name in which you want to save a new GVA file; then type or select a GVA file, or type a new 
GVA file name. 

List Files of Type    ---    displays the GVA file filter (*.gva). 

Drives    ---    select the drive that contains the directory you want, double click the directory name, and 
type or select a GVA file name; or type a new file name. 

Network    ---    opens the Connect to Network dialog box.    Connect as you normally would; then select 
the drive, directory, and GVA file you want (or type a new file name). 



Save As Dataset
Lets you save the active dataset to an HDF file. 

TIP        File > Save As > Dataset = ALT+f,a,d 

SEE ALSO 

Save As Dialog Box 



Save As Dialog Box
Use this dialog box to save the active dataset to an HDF file.    HDF files have an .hdf extension, and they 
can be saved to any directory, drive, or network drive/directory. 

File Name    ---    type an existing or new HDF file name, or select a file from the list below the File Name 
text box. 

Directories    ---    double click the directory name that contains the HDF file you want to overwrite or the 
directory to which you want to save a new HDF file; then select an existing HDF file from the list below 
the File Name text box, or type a new HDF file name. 

List Files of Type    ---    displays the HDF file filter (*.hdf). 

Drives    ---    select the drive that contains the directory you want, double click the directory name, and 
select the file name from the list; or type a new file name. 

Network    ---    opens the Connect to Network dialog box.    Connect as you normally would; then select 
the drive, directory, and HDF file you want to overwrite (or type a new file name). 



Save As Color File
Lets you save the current color tables, including the material properties and shading settings, to a color-
table (CTR) file. 

NOTE        Any color tables created after saving the active color tables are automatically saved as part of 
the active session when you select File > Save As > Session. 

TIP        File > Save As > Color File = ALT+f,a,c 

SEE ALSO 

Save As Dialog Box 



Save As Dialog Box
Use this dialog box to save the current color tables to a CTR file. CTR files have a .ctr extension, and 
they can be saved to any directory, drive, or network drive/directory. 

File Name    ---    type an existing or new CTR file name, or select a file name from the list below the File 
Name text box. 

If the existing CTR file contains a color table that has the same name as the current color table, the Color 
Table Conflict dialog box appears. 

Append    ---    adds the current color table (in memory) to the existing CTR file. 

Overwrite    ---    deletes the existing color table before saving the current color table. 

NOTE        When using Voxel Analyst on Window95, the Append and Overwrite options are not available. 
Saving a CTR file to an existing CTR file of the same name automatically overwrites the existing file. 

Directories    ---    double click the directory name that contains the CTR file you want to save, and then 
select the file from the list below the File Name text box; or type a new file name. 

List Files of Type    ---    displays the CTR file filter (*.ctr). 

Drives    ---    select the drive that contains the directory you want, double click the directory name, and 
select the file name from the list, or type a new file name. 

Network    ---    opens the Connect to Network dialog box.    Connect as you normally would, then select 
the drive, directory, and CTR file you want, or type a new file name. 



Import Submenu
Import Source Points 
Import ASCII Data File 
Import Design Elements 
Import Geometry from Grids 
Import Attributes from Grids 
Import Horizons from Grids



Import Source Points
Lets you import uninterpolated sparsely distributed data from an ASCII sample-points file, thereby 
creating a new sample-points dataset.    The new dataset is in the same X,Y,Z,A1,...A15 format that 
Convert Sparse Data to Volume Data  requires.

Once the points are imported, create a source points graphic display using Create Source Points. You can 
create a color table and manipulate the source point display like other displays.    This lets you view the 
sparsely sampled data in its original location within the dataset volume. 

TIP        File > Import > Source Points = ALT+f,i,s 

SEE ALSO 

Import Source Points Dialog Box 



Import Source Points Dialog Box
Use this dialog box to select a source points file and the data to be imported. 

Dataset    ---    displays a default name for the new dataset.    You can type a different name. 

Source Point Information: 

                Add File    ---    opens the Open dialog box , which lets you select a source points file. 

                NOTE        Source point files have an .smp extension, and they can reside in any directory, on any 
drive, or on any network drive/directory. 

                Remove File    ---    removes the file you selected to be imported. 

                Remove Attr    ---    removes an attribute from the list of data attributes to be imported; select the 
attribute to remove and click Remove Attr. 

                Attribute Name    ---    lets you rename the selected attribute.

                File Name|Column|Points|Attribute Name    ---    displays the selected source point file name, the 
data column(s) in that file, the number of source points in each data column in that file, and a default 
name for the data attribute associated with each data column. 



Open Dialog Box
Use this dialog box to select a file to be opened. 

File Name    ---    type a file name, or select a file from the list below the File Name text box. 

Directories    ---    double click the directory name that contains the file you want to open; then select the 
file from the list below the File Name text box. 

List Files of Type    ---    select a file filter (extension) from the drop-down list. 

Drives    ---    select the drive that contains the directory you want, double click the directory name, and 
select the file name from the list. 

Network    ---    opens the Connect to Network dialog box.    Connect as you normally would; then select 
the drive, directory, and file you want. 



Import ASCII Data File
Creates a new dataset when you import a 2-D grid from a Voxel Analyst-compatible ASCII Data Format 
(ADF) file into Voxel Analyst.    This lets you import the geometry, data attributes, or horizons in 2-D 
ASCII-grid files that were output from other software. 

To ensure proper orientation of the data, the input ADF file must contain the following keywords and 
information (parameters are shown in angle brackets (<      >); default parameters are shown in square 
brackets ([    ])): 

· ATTRIBUTE MGVA_INDEX <0,1,[2]>    ---    indicates the parametric index along which the data is 
listed:    0 = I, 1 = J, 2 = K.

· ATTRIBUTE MGVA_MAJOR <row, [column]>    ---    indicates the organization of the data 
within each layer.    By row, the data is interpreted as row by row; by column, the data is interpreted as 
column by column. 
· ATTRIBUTE MGVA_TYPE <[GRID]>    ---    indicates the type of data (gridded) to be loaded. 
· ATTRIBUTE <data field> [units]    ---    lists the data fields and default units. 
· POINT FORMAT statement    ---    indicates the order of the information.    If no geographic 
location is given, the default origin is (0,0,0).    For every subsequent line of data, the origin is 
incremented by 1. 

See the ADF File Formats appendix in the Voxel Analyst User's Guide for more information on the ADF 
format. 

TIP        File > Import > ASCII Data File = ALT+f,i,a 

SEE ALSO 

Import from ASCII Data File Dialog Box 



Import from ASCII Data File Dialog Box
Use this dialog box to select an ADF file to be imported and to define the name of the new dataset.    You 
can also define option-load parameters. 

File Name    ---    type an ADF file name, or click Browse and select an ADF file from the Open dialog 
box. 

NOTE        ADF files have a .adf extension, and they can reside in any directory, on any drive, or on any 
network drive/directory. 

NOTE        When you enter the input file name, load parameters are read from the file and displayed in the 
Load Parameters area. 

Dataset: 

Name    ---    displays a default name for the new dataset. You can enter a different name. 

Description    ---    type a dataset description.    This information is optional. 

Load Parameters (Read-only fields): 

        Index Range    ---    displays the active parametric range values in the I, J, and K text boxes.    (Only 
data that occurs in this range along the index shown in the Extract Along Index text box is extracted.) 

        Extract Along Index    ---    displays the active extraction parametric index    --    I, J, or K.    (Only data 
that occurs along this index within the range shown in the Index Range text boxes is extracted.) 

        2-D Grid Order    ---    displays the way the data is organized (Row Major, if the data is organized by 
rows, or Column Major, if the data is organized by columns). 

        If the data is Row Major, then the organization is: 

x1, y1, z1, a1

x1, y1, z2, a1

x1, y1, z3, a1

        If the data is Column Major, then the organization is: 

x1, y1, z1, a1
x1, y2, z1, a1
x1, y3, z1, a1



Import Design Elements
Lets you load a graphic element(s) from an AutoCad (.dwg or .dxf) or MicroStation design (.dgn) file to 
the open view(s).    Colors are the same as the colors specified in the input file's color table. 

Once the element is loaded, you can adjust its brightness (intensity) in a selected view or turn off the 
element displayed in a selected view by using the View Control commands. 

TIP        File > Import > Design Elements = ALT+f,i,d 

SEE ALSO 

Import Design Elements Dialog Box 



Import Design Elements Dialog Box
Use this dialog box to select the design elements to be imported and the import options.    You can import 
all elements, elements on selected levels only, or specific element types. 

Input File Name    ---    type an input file name, or click Browse and select an input file from the Open 
dialog box. 

All    ---    imports all design elements. 

Select    ---    enables Select Options. 

Overwrite    ---    overwrites the design elements (if any) in the open view(s). 

Overlay    ---    overlays the imported elements on any existing elements in the open view(s); existing 
elements are saved. 

Shading    ---    imports solids and surfaces as shaded solids and surfaces.    If this option is turned off, 
imported solids and surfaces appear in wireframe. 

Select Options: 

        Design File Levels    ---    type one or more levels, or click the icon and select the level(s) from the 
Multi-Level Selection dialog box. 

Types:    Select the element types you want to import. 



Multi-Level Selection Dialog Box
Use this dialog box to select levels.    You can click individual level numbers, or you can press and hold 
the mouse Data button and drag the pointer over a series of numbers. (Highlighted levels are on; 
unhighlighted levels are off.) 

Levels: 

        Numbers 1 through 63 represent the 63 levels.    By default, all levels are turned on the first time you 
use the command. 

All On    ---    turns on all 63 levels in the active view. 

All Off    ---    turns off all 63 levels in the active view. 

Reset    ---    resets the levels to the initial selection. 



Import Geometry from Grids
Lets you build an unattributed 3-D volume dataset geometry (that is, a dataset that contains only X, Y, and 
Z values) from grid files.    A grid can represent an absolute elevation, or it can represent a delta or 
difference from a reference layer.    You have the option to define by key-in a constant elevation for a 
layer that is specified.    The key-in value can also be either absolute or a delta from a reference layer. 

The X and Y values of a layer are based on X,Y values of the specified grid or on the X,Y values of a 
previous layer.    The Z values of a layer can be based on the Z values of the selected grid, or they can all 
be defined as a single value by you.    The Z values can be interpreted as values, or they can be interpreted 
based on the difference (delta) between the previous layer and the current layer. 

Import Geometry from Grids is useful for building geometries for data fields that are represented by a set 
of grid files, such as MGE Terrain Modeler (MGM) grid files.    Once the geometry is built, you populate 
it with attributes by using one of the following methods: 

· Use Import Attributes from Grids. 

· Use Import Horizons from Grids (for geologic data). 
· Save the geometry as a new HDF file by using Save As HDF, and then use Convert Sparse Data 
to Volume Data (for source-point data). 

TIP        File > Import > Geometry from Grids = ALT+f,i,g 

SEE ALSO 

Import Geometry from Grid(s) Dialog Box 



Import Geometry from Grid(s) Dialog Box
Use this dialog box to type a name and an optional description for the volume to, select a grid file, and to 
define the layer specification.    Clicking Enter posts this information to the Volume Specification area of 
the dialog box for review. 

Each line of the volume geometry is considered an entry.    An entry consists of a layer number, a grid file, 
and a geometric value.    You can edit and delete entries by using the Edit Entry and Delete Entry check 
boxes, respectively.    Clicking OK loads the geometry and exits the dialog box. 

Dataset    ---    displays a default name for the new dataset.    You can type a different name. 

Layer Specification: 

        NOTE        These controls let you define the geometry per layer. 

        Grid File    ---    click Browse and select a grid file from the Open dialog box. 

        Layer    ---    type the first layer.    (By default, the first layer is zero.)    Each successive layer after the 
first layer is consecutively numbered. 

        Void Value    ---    type a void value, if applicable.    (By default, the void value is "0.".)    This value is 
used for the geometry Z value for any voids found in the specified grids. 

        XY Geometry    ---    uses the X,Y geometry of the specified grid.    By default, this check box is on.    
When this check box is off, the X,Y geometry of the current layer is derived from a previous layer. 

        Z Definition: 

                Grid Z Value    ---    bases the Z value on the Z value of the selected grid. 

                User Keyin    ---    bases the Z value on a value that you type in the Value text box. 

                Value    ---    type a Z value.    (This text box is enabled only when the User Keyin option is 
selected.) 

        Z Interpretation: 

                Z as Value    ---    interprets the Z value as a value. 

                Z as Delta    ---    interprets the Z value as the difference between the previous layer and the 
current layer. 

                Delta from Layer    ---    type a delta value.    (This text box is enabled only when the Z as Delta 
option is selected.) 

        Enter    ---    posts the current entry (layer number, grid file, and geometric value) to the Volume 
Specification area. 

Volume Specification: 

        NOTE        These controls let you review the volume specification per entry and to edit and delete 
entries. 

        Ascending Order    ---    lists the grid files in order of ascending elevation. 

        Descending Order    ---    lists the grid files in order of descending elevation. 

        Layer|Grid File|Value    ---    displays each line of the volume specification. 

        Delete Entry    ---    deletes the selected entry. 

        Edit Entry    ---    lets you make changes to the volume specification. 



Import Attributes from Grids
Lets you define and load a volume attribution for a selected data field and create a new dataset by 
defining and loading a volume geometry and a volume attribution.    In both cases, you have the option of 
resampling the grid. 

TIP        File > Import > Attributes from Grids = ALT+f,i,t 

SEE ALSO 

Import Attributes from Grid(s) Dialog Box 
Configure Volume Attribution Dialog Box 



Import Attributes from Grid(s) Dialog Box
Use this dialog box to configure the volume attribution for an existing dataset or to configure the volume 
geometry and attribution for a new dataset.    In either case, you can select a grid resampling method. 

Dataset: 

        Existing    ---    lets you build a volume attribution for a selected data field in an existing dataset.    
Select a dataset from the drop-down list. 

        New Dataset    ---    lets you build volume geometry and attribution for a new dataset.    (Selecting this 
check box enables the Volume Geometry area.)    Type a new dataset name. 

Resample    ---    enables the Input Grid Resampling options. 

Input Grid Resampling: 

        Replace every n with average    ---    computes the average for every n entries along the grid 
column/row, and uses the result for the corresponding column/row entry in the volume.    The resulting 
volume dimension is equal to (grid dimension)/n. 

        Keep every nth entry    ---    uses every nth entry along the grid colume/row for the corresponding 
column/row entry in the volume.    All intermediate grid values are discarded.    The resulting volume 
dimension is equal to the largest integer value greater than or equal to (grid dimension)/n. 

        Interpolate into n indices    ---    linearly interpolates the entries along each grid row/column into n 
entries and uses the results to define the corresponding volume entry.    The resulting volume row/column 
dimension is equal to n. 

        Where n equals: 

                Row    ---    resamples along a row; type the value to be used for the selected resampling method. 

                Column    ---    resamples along a column; type the value to be used for the selected resampling 
method. 

Volume Geometry: 

        Layer|Grid File|Value    ---    displays the volume geometry specification you defined. 

        Configure    ---    opens the Configure Volume Geometry dialog box, which you use to define the 
volume geometry for the new dataset.    (This dialog box is identical to the Import Geometry from Grid(s) 
dialog box. 

Volume Attribution: 

        Layer|Grid File|Value    ---    displays the volume attribution you defined. 

        Configure    ---    opens the Configure Volume Attribution dialog box, which you use to define the 
attribution for the existing dataset or for the dataset you are creating. 



Configure Volume Attribution Dialog Box
The volume attribution consists of multiple-layer attribution. Configuring a layer attribution involves 
defining the attribute value and the way the value is interpreted. 

The attribute value can be based on a selected grid file, or it can be defined by you.    The value can be 
interpreted as an actual value, or it can be interpreted based on the difference (delta) between a previous 
layer and the current layer. 

Use the Configure Volume Attribution dialog box to type an attribute name, to select a grid file, and to 
define the layer attribution. Clicking Enter posts this information to the Volume Attribution area of the 
dialog box for review. 

Each line of the volume attribution is considered an entry.    An entry consists of a layer number, a grid 
file, and an attribute value.    You can edit and delete entries by using the Edit Entry and Delete Entry 
check boxes, respectively.    Clicking the OK button posts the volume attribution to the Volume 
Attribution area of the Import Attributes from Grid(s) dialog box. 

Dataset    ---    displays the active dataset and lets you select a dataset from a list. 

Description    ---    type a description of the attribute.    This information is optional. 

Layer Specification: 

        NOTE        These controls let you define the attribution per layer. 

        Layer    ---    type the current attribution layer. The number of available layers is governed by the 
dimension of your volume, with the first layer being zero and the last layer being one less than the 
dimension. 

        Grid File    ---    click Browse and select a grid file from the Open dialog box. 

Value Definition: 

        Grid Z Value    ---    bases the attribute value on the Z value of the grid file. 

        User Keyin    ---    bases the value on the value in the Value field. 

        Value    ---    type a value.    By default, the value is 0.    (This text box appears only when the User 
Keyin option is selected.) 

Z Interpretation: 

        Z as Value    ---    interprets the attribute value as a value. 

        Z as Delta    ---    interprets the value as the difference between the reference layer in the Delta from 
Layer text box and the current layer. 

        Delta from Layer    ---    type a layer to be used as a reference layer in interpreting the Z value.    (This 
text box is enabled only when the Z as Delta option is selected.) 

        Enter    ---    posts the current entry (layer number, grid file, and attribute value) to the Volume 
Attribution area. 

Volume Attribution: 

        NOTE        These controls let you review the volume attribution per entry and to edit and delete entries. 

Layer|Grid File|Value    ---    displays each line of the volume attribution. 

Delete Entry    ---    deletes the selected entry. 

Void Value    ---    type a void value, if applicable.    This value is used for representation in the data field 
for any voids found in the specified grid files. 



Attribute Units    ---    type the attribute units. 



Import Horizons from Grids
Lets you attribute an unattributed 3-D volume composed of horizon data derived from input grid files.    
Horizon data is symbolic, that is, it is represented by numbers that represent discrete qualities, such as 
lithology. Horizon attribution is defined by symbolic values bounded by specified grid files, which may 
be listed in order of ascending or descending elevation. 

TIP        File > Import > Horizons from Grids = ALT+f,i,h 

SEE ALSO 

Import Horizons from Grid(s) Dialog Box 



Import Horizons from Grids Dialog Box
Use this dialog box to select a dataset, to type a data-field name, to select a grid file from which to build 
the horizon, and to define the horizon attribution.    Clicking Enter posts this information to the Volume 
Attribution area of the dialog box for review. 

Each line of the volume attribution is considered an entry. An entry consists of a row number, a grid 
value, a grid file, and symbolic (above and below) values.    You can edit and delete entries by using the 
Edit Entry and Delete Entry options, respectively. 

Dataset    ---    select a dataset name from the drop-down list.    (By default, the first dataset listed is the 
first one that was loaded.) 

Attribute    ---    type an attribute name. 

Description    ---    type an attribute description.    This information is optional. 

Void Value    ---    type a void value, if applicable.    This value is used to represent in the attribute any 
voids found in the specified grid files. 

Horizon Attribution: 

        Row    ---    type a row number.    By default, the first row is zero.    Each successive row after the first 
row is consecutively numbered. 

        File Name    ---    click Browse and select a file from the Open dialog box. 

        NOTE        Grid files have a .grd extension, and they can reside in any directory, drive, or network 
drive/directory. 

        Average Grid Value    ---    displays the average grid value for the specified file. 

        Symbolic Values 

                Above    ---    type the symbolic value above the current row. 

                Below    ---    type the symbolic value below the current row. 

Enter    ---    posts the current entry to the Volume Attribution area. 

Volume Specification: 

        NOTE        These controls let you review the volume attribution per entry and edit and delete entries. 

        Ascending Order    ---    lists the grid files in order of ascending elevation. 

        Descending Order    ---    lists the grid files in order of descending elevation. 

        Row|Grid Value|Grid File|Above|Below    ---    displays each line of the volume attribution. 

Delete Entry    ---    deletes the selected entry. 

Edit Entry    ---    lets you make changes to the volume attribution. 



Export Submenu
Export ASCII Data File 
Export Design Elements 



Export ASCII Data File
Lets you output an ASCII-formatted 2-D grid file from 3-D volume data, creating a single ASCII file in 
Voxel Analyst-compatible ASCII Data Format (ADF). 

TIP        File > Export > ASCII Data File = ALT+f,e,a 

SEE ALSO 

Sample ADF File 
Export to ASCII Data File Dialog Box



Export to ASCII Data File Dialog Box
Use this dialog box to select the dataset to be exported and a name for the new ADF file, and to define the 
export parameters. 

Dataset    ---    select a dataset name from the drop-down list. 

File Name    ---    type the output ADF file name, or click Browse and select an ADF file from the Save As 
dialog box. 

NOTE        ADF files have a .adf extension, and they can reside in any directory, drive, or network 
drive/directory. 

Extraction Range: 

        Extract Along Index    ---    select a parametric index    -- I, J, or K    --    from the list; data that occurs 
along this index within the range specified in the Index Range fields are extracted. 

                Range    ---    display the minimum and maximum values of the extraction index.    (Read-only) 

        Index Range    ---    type the minimum and maximum values of the parametric range to be used to 
extract the data; data that occurs in this range along the index specified in the Extract Along Index field is 
extracted and output to the ADF file. 

        2-D Grid Order 

                Row Major    ---    organizes the output data by rows.    For example, 

x1, y1, z1, a1

x1, y1, z2, a1

x1, y1, z3, a1

                Column Major    ---    organizes the output data by columns.    For example, 

x1, y1, z1, a1

x1, y2, z1, a1

x1, y3, z1, a1

File Contents: 

These controls let you customize the contents of the output ADF file.    You can: 

· Enable/disable outputting selected geometry (XYZ coordinates) and/or attributes. 

· Reorder selected geometry (XYZ coordinates) and/or attributes. 

        Yes    ---    sets the Report Status of the selected coordinate or attribute to Yes and outputs it. 

        No    ---    sets the Report Status of the selected coordinate or attribute to No and does not output it. 

        Geometry|Report Status|Order    ---    display the data's XYZ coordinates, Report Status (Yes or No), 
and order number.    If the order number is 1, that coordinate is reported first.    Changes are automatically 
validated and adjusted.    For example, an order of 1,2,4,5 is adjusted to 1,2,3,4. 

        Geometry Order    ---    select the coordinate to be reordered and click either the up arrow or the down 
arrow. 

        Attribute|Report Status|Order    ---    displays the data's attributes, Report Status (Yes or No), and order 
number.    If the order number is 1, that attribute is reported first.    Changes are automatically validated 
and adjusted.    For example, an order of 1,2,4,5 is adjusted to 1,2,3,4. 



        Attribute Order    ---    select the attribute to be reordered and click either the up arrow or the down 
arrow. 



Save As Dialog Box
Use this dialog box to select a file to which to save data. 

File Name    ---    type a file name, or select a file from the list below the File Name text box. 

Directories    ---    double click the directory name that contains the file you want to save data to; then 
select the file from the list below the File Name text box. 

List Files of Type    ---    select a file filter (extension) from the drop-down list. 

Drives    ---    select the drive that contains the directory you want, double click the directory name, and 
select the file name from the list. 

Network    ---    opens the Connect to Network dialog box.    Connect as you normally would; then select 
the drive, directory, and file you want. 



Export Design Elements
Lets you output one or more graphic displays to selected levels of a MicroStation design (.dgn) file.    
Each graphic display is output as a group of elements (primarily triangular shapes, lines, and line-strings). 
Colors are translated into MicroStation colors so that when the MicroStation color table is updated, the 
colors in the output .dgn file are automatically updated.    Object color, filled shading, stroked (line-
contoured) shading, and direct shading (used in coloring symbolic data) are preserved. 

TIP        File > Export > Design Elements = ALT+f,e,d 

SEE ALSO 

Export Design Elements Dialog Box 



Export Design Elements Dialog Box
Use this dialog box to select the levels and view that contain the elements to be exported and the graphic 
representation (wire or solid).    All graphic displays can be output in wireframe mode, and all except 
boundary grids, grid outlines, sample points, and solids can be output in solid mode. 

Output File Name    ---    type an output file name, or click Browse and select a file from the Save As 
dialog box. 

Selection Criteria: 

        By View    ---    lets you select elements by view; select a view from the drop-down list. 

        By Level    ---    lets you select elements by level; type one or more levels, or click the icon and select 
levels from the Muli-Level Selection dialog box. 

        NOTE        A graphic display is not output if you have unselected it (in the Representation area) even 
though it appears in a selected view or resides on a selected level. 

Output: 

        Design File Level    ---    type the level on which to output the elements.    By default, the output level 
is 0, which places the elements on the active MicroStation level in the output .dgn file. 

        Apply Z Scale    ---    applies the current Z scale to the output elements. 

        NOTE        Z scale is applied only to the output elements, not to the elements already in the output .dgn 
file. 

Representation: 

        Wire    ---    outputs the selected graphic displays in wireframe mode. 

        Solid    ---    outputs the selected graphic displays in solid mode. 

        All (Wire)    ---    outputs all graphic displays in wireframe mode. 

        All (Solid)    ---    outputs all graphic displays in solid mode. 

        None (Wire)    ---    unselects all graphic displays for output in wireframe mode. 

        None (Solid)    ---    unselects all graphic displays for output in solid mode. 



Exit
Exits Voxel Analyst. 

TIP        File > Exit = ALT+f,x 



Edit Menu
Copy 
Fence Copy



Copy
Copies the entire contents of the active view to the Clipboard. 

NOTE        To open the Clipboard, select the ClipBook Viewer icon from the Program Manager Main 
window and select the Clipboard icon from the ClipBook Viewer window. 

TIP         = Edit > Copy (or ALT+e,c) 

SEE ALSO 
Fence Copy 



Fence Copy
Copies the contents of a fenced area of the screen to the Clipboard. 

There are two ways to copy information: 

· For copying information within a Voxel Analyst window, select the anchor point with the left mouse 
button, drag the fence across the area to be copied, and release the button. 

· For copying information from anywhere on the screen, first place the cursor over the Voxel 
Analyst window and press and hold the right mouse button.    Then select the anchor point with the left 
mouse button anywhere on the screen, drag the fence across the area to be copied, and release the button. 

NOTE        To open the Clipboard, select the ClipBook Viewer icon from the Program Manager window 
and select the Clipboard icon from the ClipBook Viewer window. 

TIP         = Edit > Fence Copy (or ALT+e,f) 

SEE ALSO 
Copy 



Dataset Menu
Dataset Information 
Delete Dataset 
Extract Dataset 
Resample Dataset 
Define Grid 
Edit Attributes 
Edit Geometry Submenu



Dataset Information
Lets you view the geometry type, the bounding volume (XYZ-coordinate minimum/maximum values), 
the grid size, the size of selected attributes, the units and data type associated with the attribute, the range 
(minimum and maximum values) of the data, and other dataset information.    Also lets you set up 
symbolic fields when interpolating with geologic units. 

TIP        Dataset > Information = ALT+d,i 

SEE ALSO 

Dataset Information Dialog Box 



Dataset Information Dialog Box
Use this dialog box to do the following: 

· View information about a selected dataset/attribute field. 

· Rename an existing dataset/attribute field. 
· Define a description for a selected dataset/attribute field. 
· Modify an existing description. 
· Modify a dataset file name. 
· Modify the units associated with a selected attribute field. 
· Modify the void value for a selected attribute field. 
· Modify the multiplier value for a specified attribute field. 

Dataset    ---    select a dataset from the drop-down list. 

Rename    ---    type a new dataset name.    (Optional) 

Description    ---    type a dataset description, or modify an existing description.    (Optional) 

File Name    ---    modify the file name under which the dataset is stored.    (Optional) 

Geometry Type    ---    displays the geometry type:    Volume (gridded data), Point (sample or source point 
data), or Irregular (irregular volume data). 

Bounding Volume: 

        NOTE        These controls display the minimum and maximum XYZ-coordinate values that define the 
boundary of the dataset volume. 

Grid Size: 

        NOTE        These controls display the IJK values that define the grid size when the Geometry Type is 
Volume. 

Attribute    ---    select a data attribute from the drop-down list. 

Rename    ---    type a new attribute name.    (Optional) 

Description    ---    type the attribute description, or modify an existing description.    (Optional) 

Units    ---    displays the units associated with the attribute.    You can type different units. 

Field Size    ---    displays the attribute size. 

Type    ---    displays the data type, for example, 32-bit floating-point. 

Range: 

        Minimum    ---    displays the minimum data value of the Attribute. 

        Maximum    ---    displays the maximum data value of the Attribute. 

        Scan    ---    scans the data and displays the minimum and maximum values. 

Void Value    ---    click the check box to enable the text box, which displays the current void value.    (By 
default, "0.".)    You can type any numeric value.    (Voxel Analyst only recognizes numeric void values.)    
This is particularly useful for data imported from MGM (MGE Terrain Modeler) grid files in which the 
void value is void. 

Multiplier    ---    click the check box to enable the text box, which displays the current multiplier value.    
(By default, "1.".)    You can type any numeric value.    This is useful for adjusting the data range 
(minimum/maximum data values).    For example, if the minimum data value is 0.1 and the maximum 



data value is 0.24, a multiplier of 10 changes the minimum value to 1 and the maximum value to 24. 

Symbolic    ---    designates that an Attribute is a symbolic field.    For example, in analyzing contaminant 
plumes, you can confine data interpolation to a specific hydrogeologic/geologic layer by specifying each 
layer as a symbolic field.    This is important for restricted interpolation and assigning individual colors to 
geologic data that was loaded as horizons or layers.    (This check box is disabled when the data type is 
Point.) 



Delete Dataset
Lets you delete the current dataset.    A Warning dialog box displays the dataset name and prompts you to 
confirm the delete.    Clicking OK deletes the dataset and removes all graphic displays associated with it. 

TIP        Dataset > Delete = ALT+d,d 



Extract Dataset
Lets you create a new dataset by extracting a subset of data from the active dataset.    (You can set the 
active dataset by using Graphics > Set Active (or ALT+g,t).) 

Once the new dataset is created, you can edit it by using Graphics > Edit. 

TIP        Dataset > Extract = ALT+d,x 

SEE ALSO 

Extract Dataset Dialog Box 



Extract Dataset Dialog Box
Use this dialog box to type the name (and an optional description) of the new dataset and to define its 
size. 

Dataset    ---    displays the active dataset.    You can select a different dataset from the drop-down list. 

Extracted Dataset: 

        Name    ---    displays a default name for the new dataset. You can type a different name. 

        Description    ---    displays a default description of the new dataset.    You can type a different 
description.    (Optional) 

Parametric Range: 

        Click this icon to open the Parametric Range dialog box , which lets you adjust the dimensions of the 
new dataset. 



Parametric Range Dialog Box
Use this dialog box to adjust the IJK parametric range (minimum and maximum values) of the graphic 
display. 

Parametric Ranges: 

        I, J, K    ---    move the sliders or type values into the text boxes to adjust the minimum/maximum I, J, 
or K parameters.    (The minimum slider bars are on top.)    The range highlights as you make adjustments. 



Resample Dataset
Lets you create a new dataset by resampling the active dataset using a method that may thin or densify the 
data.    During resampling, the dataset is checked for void values.    When processing is complete, the new 
dataset becomes the active dataset loaded in memory.    You need to save the dataset on disk when 
resampling is complete. 

TIP        Dataset > Resample = ALT+d,r 

SEE ALSO 

Resample Dataset Dialog Box 



Resample Dataset Dialog Box
Use this dialog box to select the dataset to be resampled, to type a name for the new dataset, and to select 
a resampling method. 

Input: 

        Dataset    ---    displays the active dataset name.    You can select a different dataset from the drop-
down list. 

        Number of Indices    ---    displays the IJK dimensions (parametric range limits) of the active dataset. 

Output: 

        Resampled Dataset    ---    displays a default name for the new dataset.    You can type a different 
name. 

Resample Method: 

        Keep every nth entry    ---    uses every nth entry along the grid column/row for the corresponding 
column/row entry in the volume.    All intermediate grid values are discarded.    The resulting volume 
dimension is equal to the largest integer value greater than or equal to (grid dimension)/n. 

        Replace every n with average    ---    computes the average for every n entries along the grid 
column/row, and uses the result for the corresponding column/row entry in the volume.    The resulting 
volume dimension is equal to (grid dimension)/n. 

        Add n entries between indices    ---    adds n entries between each IJK parametric index along the grid 
column/row.    The resulting volume dimension is increased by (grid dimension - 1) * n. 

        Interpolate into n indices check box    ---    linearly interpolates the entries along each grid row/column 
into n entries and uses the results to define the corresponding volume entry.    This check box can be used 
to densify or to thin the dataset.    The resulting volume row/column dimension is equal to n. 

        Where n equals    ---    resamples along the I, J, and/or K parametric axes.    Type the value(s) to be 
used for the selected resampling method. 



Define Grid
Lets you define a uniform, regular, or irregular 3-D grid for a selected dataset using interactive graphics to 
add grid slices to any or all of the dataset's IJK parametric axes.    You also can copy the geometry of an 
existing grid or modify an existing grid's geometry (including structured grids).    To modify an existing 
grid, you can densify it (add new slices to it) and/or thin it (delete existing slices from it). 

See the Glossary in the Voxel Analyst User's Guide for definitions of uniform, regular, irregular, and 
structured grids. 

NOTE        When you modify an existing grid's geometry, any data fields associated with it are lost. 

When defining a new grid or geometry, an empty (unattributed) dataset is created (and it becomes the 
active dataset).    The new dataset can be modified and populated by using one of the following methods: 

· Use Import Datafields from Grids. 

· Use Import Horizons from Grids (for geologic data). 
· Save the geometry as a new HDF file by using Save As HDF, and then use Convert Sparse Data 
to Volume Data (for source-point data). 

If you are working with sparse (sample) data points, the saved HDF file can optionally be input into 
Convert Sparse Data to Volume Data as the control geometry or as the minimum bounding volume 
(MBV). 

TIP        Dataset > Define Grid = ALT+d,g 

SEE ALSO 

Define Grid Dialog Box 



Define Grid Dialog Box
Use this dialog box to select an existing dataset (or to type a new dataset name), to define the grid size, to 
add one or more grid slices, and to delete one or more grid slices.    (Defaults are provided for a new 
dataset name and grid size.) 

Dataset    ---    displays a default dataset name.    You can type a different name or select an existing dataset 
name from the drop-down list. 

NOTE        If you type an existing dataset name, a confirmation dialog box appears.    Click Yes to modify 
the existing dataset (any data fields associated with the grid are lost); click No to copy the existing dataset 
(without its associated data fields) to a new dataset.    Click Cancel to default to the active dataset. 

Grid Size (IJK): 

        These text boxes display IJK parameter values for the grid size.    (By default, the size is 2x2x2.)    
You can change the grid size to the required resolution by typing new IJK values in the text boxes. 

NOTE        If you want to change the grid size, you must do so before adding/deleting grid slices. 

NOTE        The default minimum bounding volume (MBV) for the new dataset is the MBV of the active 
dataset.    If no dataset is loaded, the MBV is arbitrary. 

Slice Operations: 

        IJK    ---    select the parametric axis for which you want to add/delete grid slice(s).    (By default, the I 
axis is selected.    This corresponds to adding horizontal slices that are perpendicular to the Z axis.) 

        Add Single    ---    lets you add a single grid slice. 

        Add Multiple    ---    lets you add multiple grid slices.    Type the number of slices in the Number of 
Slices text box. 

        Number of Slices    ---    type the number of slices to be added to the grid.    (By default, the number of 
slices is 2.) (This text box is disabled when adding/deleting single slices or when deleting multiple slices.) 

        Delete Single    ---    lets you delete a single slice. 

        Delete Multiple    ---    lets you delete multiple grid slices. 

Display All Surfaces    ---    displays all grid slices (surfaces); otherwise, only the surfaces perpendicular to 
the active axis are displayed. 

Undo    ---    undoes each addition/deletion in reverse order beginning with the last addition/deletion. 



Edit Attributes
Lets you edit values in a selected data field of a 3-D grid.    Optionally, you can construct a local geometry 
(cube) or area of influence centered around the edited data point (within the dataset's parametric space) 
and reinterpolate the data within the cube.    This lets you visualize connected data such as contaminant 
plumes.    It also lets you edit out bad data and to volume digitize/interpret new data into the model. 

Edit Attributes reinterpolates data field values on all grid nodes in the cube.    The grid nodes immediately 
next to the cube and the center node are used as input points for the reinterpolation, or the edges can be 
used for faster interpolation. Constant interpolation applies the value of the center node to all nodes 
within the influence range. 

NOTE        The active dataset must be gridded data.    To see immediate visual results, you must have 
created at least one graphic display.    It is also recommended that you create a color table using Create 
Color Table. 

TIP        Dataset > Edit Attributes = ALT+d,a 

SEE ALSO 

Edit Attributes Dialog Box 



Edit Attributes Dialog Box
Use this dialog box to select the dataset for which you want to edit attributes, to modify the center node, 
to define the cube or influence range for the interpolation, to select a data field for the interpolation, to 
select an interpolation method, to modify the attribute value, and to apply an interpolation. 

Dataset    ---    displays the active dataset name.    You can select a different dataset from the drop-down 
list. 

Node Selection: 

        Center Node    ---    move the sliders or type values to adjust the I, J, or K parameters of the center 
nodes, which are highlighted by a cross-hair in the view. 

        Plane I, J, K    --- select the appropriate check box to define the parametric plane for which the cross-
hair is drawn. 

        X, Y, Z    ---    display the XYZ coordinates for the selected center node. 

        Influence Range    ---    move the sliders or type values to adjust the cube geometry (the number of 
grid nodes in each direction).    The cube is highlighted as you make adjustments.    When the range is 
0,0,0, no neighboring nodes are affected; only the center node is modified. 

Interpolation Method: 

        Select an algorithm from the drop-down list as follows: 

        Constant    ---    applies the value of the center node to all nodes within the influence range. 

        Metric Power    ---    type a value in the Metric Power text box.    (The power parameter defines how 
much each input data value affects the values of its nearby output points.    A power of ten is large.    A 
power less than one is small.    Small power is not recommended.    The power cannot be less than zero.) 

        Fast    ---    interpolates with fewer input data points resulting in faster processing.    This is especially 
true for the Multiquadric, Thin-plate Spline, and Volume Spline algorithms. 

        NOTE        When Fast is on, only the grid nodes immediately next to the edges of the cube are used as 
input points. The reinterpolated values deviate more from the previous values than when Fast is off.    
When Fast is off, all grid nodes next to the cube surfaces are used as input points. 

Attribute Values: 

        Field|Value    ---    displays the data-field name(s) and values in the active dataset. 

        New Value    ---    select the value you want to change and type a new value in this text box. 

        Apply    ---    processes the interpolation. 

        Undo    ---    undoes each interpolation in the order it was processed and resets the data-field value(s) 
and the influence range to their previous settings. 



Edit Geometry Submenu
Dataset Origin 
Move Dataset 
Rotate Dataset 
Scale Dataset 
Organize Dataset 
Identity Matrix 
Primary Matrix



Dataset Origin
Lets you edit the active dataset X-, Y-, and Z-coordinate origin values. 

TIP        Dataset > Edit Geometry > Origin = ALT+d,e,o 

SEE ALSO 

Dataset Origin Dialog Box 



Dataset Origin Dialog Box
Use this dialog box to select a dataset to edit, to view the current X-, Y-, and Z-coordinate values (relative 
to the previous values), and to edit the values.    You can type new origin values or you can interactively 
define a new origin point in the active view. 

Dataset    ---    select a dataset from the drop-down list. 

Apply    ---    applies the current origin values to the active dataset. 

Undo    ---    undoes the last changes and restores the values to the previous values. 

Highlighting    ---    lets you interactively select a new origin point; the X-, Y-, and Z-coordinate origin 
values appear in the corresponding text boxes.    (Click to return to the dialog box without changing the 
origin.) 

Origin Information: 

        X Origin    ---    displays the current X-coordinate origin; type a new value. 

        Y Origin    ---    displays the current Y-coordinate origin; type a new value. 

        Z Origin    ---    displays the current Z-coordinate origin; type a new value. 

NOTE        Current units appear in read-only text fields. 



Move Dataset
Lets you move the active dataset a specified distance in any X-, Y-, or Z-coordinate direction. 

TIP        Dataset > Edit Geometry > Move = ALT+d,e,m 

SEE ALSO 

Move Dataset Dialog Box 



Move Dataset Dialog Box
Use this dialog box to select a dataset to move and to type the X-, Y-, and Z-coordinate distance values.    
You can also interactively define a new translation vector in the active view. 

Dataset    ---    displays the active dataset name.    You can select a different dataset from the drop-down 
list. 

Apply    ---    applies the new distances to the active dataset. 

Undo    ---    undoes the last changes and restores the distance values to the previous values. 

Highlighting    ---    lets you interactively select two points to form a translation vector; the X-, Y-, and Z-
coordinate distances appear in the corresponding text boxes.    (Tap the mouse Reset button to return to the 
dialog box without changing the location.) 

Translation Information: 

        X Distance    ---    displays the current X-coordinate distance.    Type a new value. 

        Y Distance    ---    displays the current Y-coordinate distance.    Type a new value. 

        Z Distance    ---    displays the current Z-coordinate distance.    Type a new value. 

NOTE        Current units appear in read-only text fields. 



Rotate Dataset
Lets you rotate the active dataset a specified angle relative to any X, Y, Z axis. 

TIP        Dataset > Edit Geometry > Rotate = ALT+d,e,r 

SEE ALSO 

Rotate Dataset Dialog Box 



Rotate Dataset Dialog Box
Use this dialog box to select a dataset to rotate, to view the current X-, Y-, and Z-axis rotation angles 
(relative to the previous rotation angles), and to edit the values.    You can type new angles or you can 
interactively define a new angle for each axis. 

Dataset    ---    displays the active dataset name.    You can select a different dataset from the drop-down 
list. 

Apply    ---    applies the current rotation angles to the active dataset. 

Undo    ---    undoes the last changes and restores the values to the previous values. 

Highlighting    ---    lets you interactively select a rotation angle for the selected axis; the corresponding 
value appears in the appropriate text box.    (Tap the mouse Reset button to return to the dialog box 
without changing the rotation.) 

Rotation Information: 

        X Angle    ---    displays the current X-coordinate rotation angle.    Type a new value. 

        Y Angle    ---    displays the current Y-coordinate rotation angle.    Type a new value. 

        Z Angle    ---    displays the current Z-coordinate rotation angle.    Type a new value. 

        X Axis    ---    sets the active axis to X; changes effect the X axis only. 

        Y Axis    ---    sets the active axis to Y; changes effect the Y axis only. 

        Z Axis    ---    sets the active axis to Z; changes effect the Z axis only. 

NOTE        The compass rose will rotate the dataset from 0 to +180 degrees if it is moved in a clockwise 
direction, or 0 to -180 degrees if moved in a counter-clockwise direction. 



Scale Dataset
Lets you scale the active dataset a specified percent relative to any X, Y, Z axis. 

TIP        Dataset > Edit Geometry > Scale = ALT+d,e,s 

SEE ALSO 

Scale Dataset Dialog Box 



Scale Dataset Dialog Box
Use this dialog box to select a dataset to scale, to view the current X-, Y-, and Z-axis scale values (relative 
to the previous values),    and to edit the values.    You can type new values or you can interactively define 
new values for each axis. 

Dataset    ---    displays the active dataset name.    You can select a different dataset from the drop-down 
list. 

Apply    ---    applies the current scale to the active dataset. 

Undo    ---    undoes the last change and restores the value to the previous value. 

Highlighting    ---    lets you interactively select a scale for the selected axis; the corresponding value 
appears in the appropriate text box.    (Tap the mouse Reset button to return to the dialog box without 
changing the scale.) 

Scale Information: 

        X Scale    ---    displays the current X-coordinate scale.    Type a new value. 

        Y Scale    ---    displays the current Y-coordinate scale.    Type a new value. 

        Z Scale    ---    displays the current Z-coordinate scale.    Type a new value. 

        X Axis    ---    sets the active axis to X; changes effect the X axis only. 

        Y Axis    ---    sets the active axis to Y; changes effect the Y axis only. 

        Z Axis    ---    sets the active axis to Z; changes effect the Z axis only. 

NOTE        The interactive scale symbol will scale the active dataset relative to its origin.    The symbol 
has tick marks ranging from -100% to +100% at 25% intervals. 



Organize Dataset
Lets you rearrange the order of the gridded geometric or data-field information.    Frequently, data 
imported from new sources through the ASCII to HDF translator has the grid entries ordered differently 
than Voxel Analyst expects, for example, output from FORTRAN programs. 

If the loaded dataset contains iso-surfaces that are broken into small, scattered pieces with strong diagonal 
patterns, if the iso-surface is upside down or mirrored, or if axes seem to be exchanged, then you can use 
Organize Dataset to correct the problem. 

Ordering or axis mirroring problems are shown with the diagonally patterned breakup of iso-surfaces or 
contours.    They can also be detected by inspecting the data with respect to any design elements to 
determine if the display makes sense in the context of the design elements. 

TIP        Dataset > Edit Geometry > Organize = ALT+d,e,z 

SEE ALSO 

Organize Dataset Dialog Box 



Organize Dataset Dialog Box
Use this dialog box to do the following: 

· Exchange the parametric axes (dimensions) of the dataset. 

· Reorder the coordinate data of a particular coordinate (X, Y, or Z) through mirroring along a 
parametric axis or by exchanging parametric (I,J,K) axes. 
· Mirror an attribute along a parametric axis. 
· Reorder an attribute by transposing parametric axes. 

Dataset    ---    displays the active dataset name.    You can select a different dataset from the drop-down 
list. 

Rearrange Grid: 

        NOTE        These controls let you rearrange the IJK attributes associated with the XYZ coordinates of 
the active dataset model grid. 

        Dimensions    ---    select this option to exchange the dimensions of the grid. 

        X Coordinates, Y Coordinates, Z Coordinates    ---    select the appropriate option to rearrange the 
coordinate data of the selected coordinate only. 

        Reverse    ---    select the check box or boxes that correspond to the parametric direction to be 
reversed. 

        Exchange    ---    select the option that corresponds to the order in which you want the geometric 
coordinates to be arranged. 

Rearrange Attribute: 

        NOTE        These controls let you rearrange the data of the selected attribute. 

        Attribute    ---    select an attribute from the drop-down list.    (The attributes differ according to the 
active dataset.) 

        Reverse    ---    select the check box or boxes that correspond to the parametric direction to be 
reversed. 

        Exchange    ---    select the option that corresponds to the order in which you want the attributes to be 
arranged. 



Identity Matrix
Sets the active dataset orientation matrix (a 4 X 4 transformation matrix that positions the dataset 
geometry) to the identity matrix, thereby removing any rotation, scale, or translation represented in the 
matrix. 

An identity matrix consists of all ones along the main diagonal and zeros everywhere else.    For example, 

1    0    0    0
0    1    0    0
0    0    1    0
0    0    0    1

TIP        Dataset > Edit Geometry > Identity Matrix = ALT+d,e,i 

NOTE        Identity Matrix does not require software prompts or dialog boxes. 



Primary Matrix
Sets the active dataset orientation matrix to the matrix that transforms the dataset's points from MCSO 
(MGE Coordinate System Operations) primary coordinates to the active design file UORs (units of 
resolution).    The resulting equations are as follows: 

Xuor = Xgrd * Xresolution + Xglobal_origin

Yuor = Ygrd * Yresolution + Yglobal_origin

Zuor = Zscale * Zgrd * Zresolution + Zglobal_origin

NOTE        Without MCSO coordinates, an identity matrix is substituted for the orientation matrix when 
Primary Dataset is selected.    See the Glossary in the Voxel Analyst Users Guide for more information on 
matrices. 

Primary Matrix is useful for registering an unregistered dataset to a MicroStation design file.    For 
example, if you do not select a design file when converting sparse data to volume data, the resulting 
dataset is not registered with a design file and does not match the active design file elements. 

Another example of an unregistered dataset is an Voxel Analyst-specific ASCII file in which MCSO 
primary coordinates are used for the Bounding_vol and Points_xor values instead of UORs. 

TIP        Dataset > Edit Geometry > Primary Matrix = ALT+d,e,p 

NOTE        Primary Matrix does not require software prompts or dialog boxes. 



Color Table Menu
Create Color Table 
Adjust Range 
Manipulate Color Table 
Edit Color Table 
Edit Material Properties 
Edit Shading Method 
Legend Setup 
Legend Display



Create Color Table
Lets you create a new color table for a selected attribute.    The data values in an attribute range from a 
minimum value to a maximum value.    You can divide the data range into subranges and define start and 
end values and colors for each subrange. 

NOTE        If you exit Voxel Analyst without first saving the newly created color table to a file and without 
saving the current session to a file, the color table is not saved.    To save the color table, select File > Save 
As > Color File. 

TIP        Color Table > Create = ALT+c,c 

SEE ALSO 

Create Color Table Dialog Box 



Create Color Table Dialog Box
Use this dialog box to type a color table name, to select a dataset, and to define (for each attribute) the 
beginning and ending colors and data values for each subrange of the color table.    (A default color-table 
name is provided.) 

Color Table    ---    type a new color-table name. 

Below Range Color    ---    displays the color for data that occurs below the data-value range.    Click the 
box to open the Adjust Color dialog box , which lets you define the color. 

Above Range Color    ---    displays the color for data that occurs above the data-value range.    Click the 
box to open the Adjust Color dialog box , which lets you define the color. 

Current Range Information: 

        Dataset    ---    select a dataset from the drop-down list. The related attributes and minimum/maximum 
data values appear in the fields below. 

        Attribute|Minimum|Maximum    ---    display the attributes and data range in the selected dataset.    
Select an attribute to set up interval definition. 

Interval Definition: 

        Number of Intervals    ---    type the number of intervals. (This number determines the division of data 
values within the data-value range.) 

        Increment    ---    type the number by which the data is incremented.    (When the increment is 
modified, the ending data value is automatically updated.) 

        Values Beginning    ---    type the beginning data value. 

        Values Ending    ---    type the ending data value. 

        NOTE        The beginning and ending values define the range of values for each color-table subrange. 

        Colors Beginning    ---    displays the color assigned to the beginning data value.    Click the box to 
open the Adjust Color dialog box , which lets you define color. 

        Colors Ending    ---    displays the color assigned to the ending data value.    Click the box to open the 
Adjust Color dialog box , which lets you define color. 

        NOTE        The beginning and ending colors are used to determine the range of colors assigned to the 
data-value range. 

        Delete    ---    deletes the current interval definition for a selected attribute. 

        Previous    ---    moves to the previous subrange of the new color table. 

        Next    ---    moves to the next subrange of the new color table. 

        NOTE        Each color table may be composed of several subranges. Clicking OK merges the 
subranges together. 



Adjust Color Dialog Box
Use this dialog box to define a color or, optionally, to define no color for a data value.    Shades of red, 
green, and blue are represented by numeric values ranging from 0.00 to 1.00 percent.    Any combination 
of red, green, or blue can be defined.    The color is interactively displayed. 

NOTE        When no color is used, the values for the assigned ranges will not be represented by any color. 
For display purposes only, it will be as if no data exists for these ranges. 

Red, Green, and Blue    ---    type numeric values or move the sliders to define a color (0% red, 0% green, 
and 0% blue is black).    The color adjusts as you change the percentages. 



Adjust Range
Lets you adjust the active color table data-value range (minimum and maximum data values) for each 
attribute in a selected dataset.    You can scale or clip values ranges according to new minimum and/or 
maximum data values that you define. 

Scaling redistributes the data-value assignments in the associated color table over the new range and 
maintains the original number of colors (intervals).    Clipping cuts off the data values above and below 
the new range and does not maintain the original number of colors (intervals).    You also have the option 
to maintain the active color/data-value labels (if any). 

TIP        Color Table > Adjust Range = ALT+c,a 

SEE ALSO 

Adjust Range Dialog Box 



Adjust Range Dialog Box
Use this dialog box to select a color table, a dataset, and the attributes for which you want to adjust the 
value range.    Define new minimum and/or maximum values for each value range you want to adjust and 
select the option (Scale Value Range or Clip Value Range) you want to use. 

Color Table    ---    select a color table from the drop-down list. 

Current Range Information: 

        Dataset    ---    select a dataset from the drop-down list. The related attributes or data fields and the 
data-range limits appear in the fields below. 

        Attribute|Minimum|Maximum    ---    review the data-range limits in each attribute. 

Color Table Value Range: 

        Current Minimum    ---    displays the active minimum data value. 

        New Minimum    ---    displays the minimum data value to which the data will be scaled or clipped. 

        Current Maximum    ---    displays the active maximum data value. 

        New Maximum    ---    displays the maximum data value to which the data will be scaled or clipped. 

        Adjust ---    scales or clips the data according to the New Minimum and/or New Maximum values. 

        Apply Options: 

                Scale Value Range    ---    redistributes the data values according to the New Minimum and New 
Maximum values while maintaining the original number of intervals and colors. 

                Clip Value Range    ---    cuts off the data values that fall outside the New Minimum and New 
Maximum values without maintaining the original number of intervals and colors. 

                Maintain Current Label Settings    ---    maintains the active color/data-value labels (if any are 
defined) in the associated color table.    (If this option is not selected, the labels are not maintained in the 
edited color table.) 



Manipulate Color Table(s)
Lets you rename, copy, and delete color tables. 

TIP        Color Table > Manipulate = ALT+c,m 

SEE ALSO 

Manipulate Color Table(s) Dialog Box 



Manipulate Color Table(s) Dialog Box
Use this dialog box to select the color table to be renamed/copied/deleted. 

Current Color Table(s)    ---    displays the current color-table names. 

Color Table Name    ---    type a new color-table name to rename a selected table or to rename a copy of a 
selected table. 

Copy    ---    creates a copy of the selected table (using a default name) and displays the name in the 
Current Color Table(s) list. 

NOTE        Unless you type another name in the Color Table Name text box, the table is saved under the 
default name when you click OK. 

Delete    ---    permanently deletes the selected color table. 



Edit Color Table
Lets you review and edit the color/data value assignments (entries) in a selected color table.    An entry 
consists of a data value, its associated value-specific color, and an optional label. You can change the 
colors of related graphic displays (objects) from the current range of value-specific colors to a constant 
color that you define.    Or, you can define the color as no color, which causes the display to appear 
transparent. 

TIP        Color Table > Edit = ALT+c,e 

SEE ALSO 

Edit Color Table Dialog Box 



Edit Color Table Dialog Box
Use this dialog box to select a color table, to define object color (constant or value specific), and to add, 
edit, and/or delete color-table entries. 

Color Table    ---    displays the active color table of the color tables in memory.    You can select a different 
table from the drop-down list.    The color/data value assignments appear in the scrolling field in the Value 
Specific Colors area. 

Object Color Options: 

        Constant Color    ---    causes the object color to appear constant, rather than determined by the range 
of data values in the selected color table.    Click the box to open the Adjust Color dialog box , which lets 
you define color or select no color. 

        Value Specific    ---    enables the Value Specific Colors area, which lets you edit the color/data value 
assignments. 

Value Specific Colors: 

        Value    ---    displays current data values and lets you type a data value to assign to the adjacent color. 

        Label    ---    type a label for the selected data value.    (Optional) 

        Color    ---    opens the Adjust Color dialog box , which lets you define color or select no color for the 
adjacent data value. 

        Increment    ---    type a number by which to increment the selected data value. 

        Enter    ---    increments the selected value by the increment value for possible use.    Adds the changes 
to the current color/data-value assignments, letting you review the changes before saving them. 

        Delete    ---    deletes each entry that you select from the current color/data value assignments. 



Edit Material Properties
Lets you control shading, highlighting, reflection, and other material properties that affect the appearance 
of the surfaces of graphic displays. 

NOTE        You can see the effects of changing material properties by creating a graphic display and 
changing various material-properties values. 

TIP        Color Table > Material Properties = ALT+c,p 

SEE ALSO 

Edit Material Properties Dialog Box 



Edit Material Properties Dialog Box
Use this dialog box to define values for material properties.    The values can be stored in a selected color 
table.    The surface appearance of graphic displays is determined by the material properties stored in the 
related color-table file. 

Color Table    ---    displays the active color-table name. You can select a different color table from the 
drop-down list.    The material properties defined in the table appear on the dialog. 

Reflection Coefficients: 

        Type values or move the sliders to define each reflection coefficient as a percentage (0 - 100): 

        Ambient    ---    causes the object to appear as if the light source surrounds it. 

        Diffuse    ---    causes the object to appear as if the light source originates from a single point, 
producing shading and a three-dimensional appearance. 

        Specular    ---    causes the object to appear more reflective. 

        NOTE        The higher the reflection coefficient, the greater the reflection of light off the object.    See 
the Glossary in the Voxel Analyst Users Guide for more information. 

Specular: 

        Gloss    ---    type a gloss value or move the slider to define gloss (0 - 100 percent, where 0=dull gloss 
and 100=high gloss). 

        Color    ---    opens the Adjust Color dialog box , which lets you define the color of the specular 
reflection. 

        Smoothing    ---    causes the surface of the object to appear smooth. 



Edit Shading Method
Lets you select the shading method associated with a selected color table. 

TIP        Color Table > Edit Shading Method = ALT+c,s 

SEE ALSO 

Edit Shading Method Dialog Box 



Edit Shading Method Dialog Box
Use this dialog box to select a color table and a shading method. 

Color Table    ---    select a color table name from the drop-down list. 

Shading Method: 

        Edges    ---    creates colored lines at interval edges. 

        Filled    ---    creates filled colors in which each interval has a constant color. 

        Smooth    ---    creates smooth blending from one color to the next. 

        Blended    ---    blends the selected color to a constant color and enables the Blend Options. 

        Blend Options: 

                Blend to Value Color    ---    blends from the blend color to each interval color. 

                Blend from Value Color    ---    blends from each interval color to the blend color. 

                Blend Color    ---    opens the Adjust Color dialog box , which lets you define a constant color for 
each range to blend into. 



Legend Setup
Lets you define the configuration of a legend to show the color/data value assignments in a selected color 
table.    Once the configuration is defined, you can display the legend by selecting Color Table > Legend 
Display. 

TIP        Color Table > Legend Setup = ALT+c,l 

SEE ALSO 

Legend Setup Dialog Box Legend Display 



Legend Setup Dialog Box
Use this dialog box to select a color table and to type a title and optional subtitle for the legend and the 
precision for the data values.    You can set the legend orientation to horizontal or vertical, and you display 
data values only, labels only, or both data values and labels. 

Color Table    ---    select a color table name from the drop-down list. 

Legend Title    ---    type a legend title.    (By default, the title is Legend.) 

Subtitle    ---    type a subtitle, such as the units, for the data values.    For example, ppm (parts per million). 
(By default, the subtitle is Values.) 

Precision    ---    type the number of significant digits for the data values.    (By default, the number is 5.) 

Orientation: 

        Vertical    ---    displays a vertical legend. 

        Horizontal    ---    displays a horizontal legend. 

Display Status: 

        Value    ---    displays data values. 

        Label    ---    displays labels, unless you have not defined any. 



Legend Display
Lets you display a legend that shows the color assigned to each data range in a selected color table.    At 
the minimum, a legend consists of a title and a list of the colors defined in the table.    You can also 
display the data values, a subtitle for the data values, and the labels (if any were created) for each 
color/data-value assignment. 

To place a legend or legend title in the active window, press the mouse Reset button while the pointer is 
on the legend dialog box.    Using the menu that opens, you can set the title or legend origin by clicking 
the appropriate location in the active view. 

NOTES        You can modify a color by clicking its box, which opens the Adjust Color dialog box.    The 
legend can be manipulated like a regular window.    You can collapse it, move it to another location, and 
resize it to accommodate a long title. 

TIP        Color Table > Legend Display = ALT+c,d 

SEE ALSO 

Legend Setup 



Graphics Menu
Create Source Points 
Create Outline 
Create Boundary Grid 
Create Solid 
Create Chair 
Create Iso-Solid 
Create Iso-Surface 
Create Envelope 
Create Iso-Parametric 
Create Cap 
Create Cutting Plane 
Change Mode Submenu 
Set Active 
Edit (Graphic) 
Delete (Graphic)

TIP         turns on the Graphics Bar.



Create Source Points
Lets you view sparsely or irregularly sampled source points as a Voxel Analyst graphic display.    This 
command performs a linear interpolation of the source points to their cubic weights or sizes. The 
interpolation is based on the minimum/maximum (low/high) attribute values and the data size values that 
you define.    The units are design file units, such as feet.    The resulting graphic display can be edited and 
manipulated like other graphic displays. 

The coloring, interval shading, and material properties of the cubes are determined by the selected 
shading attribute and color table. The color table can be edited by clicking Edit. 

TIP         = Graphics > Source Points (or ALT+g,u) 

SEE ALSO 
Create Source Points Dialog Box 



Create Source Points Dialog Box
Use this dialog box to select the dataset you want to view and a shading attribute and color table.    Then 
define the source-points data range (low and high values) and data-size range (low and high values) on 
which to base the linear interpolation. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute will be used to control the 
shading of the source-points display. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you adjust the color/data value 
assignments in the selected color table. 

Level    ---    type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style    ---    click the icon to open the Style dialog box. 

Source Points: 

        Value: 

                Low    ---    move the slider or type a value (floating-point number) for the low end of the data 
range. 

                High    ---    move the slider or type a value (floating-point number) for the high end of the data 
range. 

        Size: 

                Low    ---    move the slider or type a value (floating-point number) for the low end of the data 
size. The default units are design file units. 

                High    ---    move the slider or type a value (floating-point number) for the high end of the data 
size. The default units are design file units. 



Single-Level Selection Dialog Box
Use this dialog box to select the level on which to place a graphic display. 

Levels: 

        Click the number you want; sixty-three levels are available. 

Reset    ---    resets the level to the level that was selected when the dialog box initially appeared. 



Style Dialog Box
Use this dialog box to select the display mode and the transparency setting in which the graphic display 
will appear. 

Display Mode: 

        Shaded    ---    places the graphic display in shaded mode. 

        Wireframe    ---    places the graphic display in wireframe mode. 

        Sketch    ---    places the graphic display in sketch mode. 

Transparency: 

        Move the slider or type a value (as a percent of 100). 



Create Outline
Lets you create a reference grid outline for the selected dataset. 

TIP         = Graphics > Outline (or ALT+g,o) 

SEE ALSO 
Create Outline Dialog Box 



Create Grid Outline Dialog Box
Use this dialog box to select a dataset, color, level, and style for the grid outline. 

Dataset    ---    select a dataset from the drop-down list. 

Color: 

        Click the color box to open the Adjust Color Dialog Box , which lets you define a color for the 
outline. 

Level: 

        Type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style: 

        Click the icon to open the Style dialog box. 



Create Boundary Grid
Lets you create a reference boundary grid for a selected dataset. You interactively adjust the IJK 
parametric range (minimum and maximum values) of the boundary grid.    (The parametric range defines 
the dimensions of the boundary grid in three directions.)    This is also a good tool to use for looking for 
overlapping grids when loading horizons. 

The coloring, shading, and material properties of the grid are determined by the selected shading attribute 
and color table. The color table can be edited by clicking Edit. 

TIP         = Graphics > Boundary Grid (or ALT+g,b) 

SEE ALSO 
Create Boundary Grid Dialog Box 



Create Boundary Grid Dialog Box
Use this dialog box to select a dataset, to define the boundary grid shading, and to access dialog boxes for 
defining the grid's parametric range, the level on which to place it, and the style in which it appears. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute is used to control shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you adjust the color/data value 
assignments in the selected color table. 

Range: 

        Click the icon to open the Parametric Range dialog box. 

Level: 

        Type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style: 

        Click the icon to open the Style dialog box. 



Create Solid
Lets you create a solid block for a selected dataset.    You interactively adjust the IJK parametric range 
(minimum and maximum IJK values) of the block.    (The parametric range defines the dimensions of the 
block in three directions.) 

The coloring, interval shading, and material properties of the block are determined by the selected 
shading attribute and color table. The color table can be edited by clicking Edit. 

TIP         = Graphics > Solid (or ALT+g,s) 

SEE ALSO 

Create Solid Dialog Box 



Create Solid Dialog Box
Use this dialog box to select a dataset, to define the solid shading, and to access dialog boxes for defining 
the solid's parametric range, the level on which to place it, and the style in which it appears. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute controls shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you adjust the color/data value 
assignments in the selected color table. 

Range: 

        Click the icon to open the Parametric Range dialog box. 

Level: 

        Type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style: 

        Click the icon to open the Style dialog box. 



Create Chair
Lets you create a chair-shaped graphic display for a selected dataset.    (A "chair" is a box with a notch cut 
into one corner, revealing the interior of the dataset.)    You interactively adjust the IJK parametric range 
(minimum and maximum values) of the chair.    (The parametric range defines the dimensions of the chair 
in three directions.) 

The coloring, interval shading, and material properties of the chair are determined by the selected shading 
attribute and color table.    The color table can be edited by clicking Edit. 

TIP         Graphics > Chair (or ALT+g,c) 

SEE ALSO 
Create Chair Dialog Box 



Create Chair Dialog Box
Use this dialog box to select a dataset, to define the chair shading, and to access dialog boxes for defining 
the chair's parametric range, the level on which to place it, and the style in which it appears.    You can 
also adjust the dimensions of the notch using the Notch Range sliders.    The notch origin can be any one 
of eight different corners. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute controls shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you edit the color/data value assignments 
in the selected color table. 

Range: 

        Click the icon to open the Parametric Range dialog box. 

Level: 

        Type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style: 

        Click the icon to open the Style dialog box. 

Chair: 

        Notch Origin (0-7)    ---    select a notch origin.    To determine the origin, review the notch-origin 
diagram.    The selected origin is highlighted.    You can also change the notch origin by clicking the 
corresponding number on the diagram. 

        Notch Range: 

                I, J, K    ---    move the sliders or type values to adjust the I, J, or K parameters or dimensions of 
the notch. 



Create Iso-Solid
Lets you create a 3-D solid of all points in a selected dataset with a constant upper and lower data range 
for a selected attribute.    You adjust the range (high and low values) of the iso-solid to suit the selected 
dataset. 

The coloring, interval shading, and material properties of the iso-solid are determined by the selected 
shading attribute and color table.    The color table can be edited by clicking Edit. 

TIP         = Graphics > Iso-Solid (or ALT+g,i) 

SEE ALSO 

Create Iso-Solid Dialog Box 



Create Iso-Solid Dialog Box
Use this dialog box to select a dataset, to define the iso-solid shading, and to access dialog boxes for 
defining the iso-solid's parametric range, the level on which to place it, and the style in which it appears. 
You select an iso-solid attribute and adjust the iso-solid's data-value range (low and high values).    The 
geometry of the iso-solid is determined by the iso-solid attribute, which can be the same as the shading 
attribute. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute controls shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you edit the color/data value assignments 
in the selected color table. 

Range: 

        Click the icon to open the Parametric Range dialog box. 

Level: 

        Type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style: 

        Click the icon to open the Style dialog box. 

Iso-Solid: 

        Attribute    ---    select an attribute on which to base the iso-solid from the drop-down list. 

        Values: 

                Low, High    ---    move the sliders or type values to adjust the data range (the minimum/maximum 
values) of the iso-solid. 



Create Iso-Surface
Lets you create an open-ended 3-D surface that fits through all points in the active dataset with a constant 
value for an attribute. You adjust the value to be displayed to suit the selected dataset.    (This can be 
thought of as a 3-D version of a contour line on a topographic map.)

The coloring, interval shading, and material properties of the volume surrounding the constant data values 
are determined by the selected shading attribute and color table.    The color table can be edited by 
clicking Edit. 

TIP         =    Graphics > Iso-Surface (or ALT+g,f) 

SEE ALSO 
Create Iso-Surface Dialog Box 



Create Iso-Surface Dialog Box
Use this dialog box to select a dataset, to define the iso-surface shading, and to access dialog boxes for 
defining the iso-surface range, the level on which to place it, and the style in which it appears. 

You also select an iso-surface attribute.    The geometry of the iso-surface is determined by the selected 
iso-surface attribute.    This attribute can be the same as the shading attribute. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute controls shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you edit the color/data value assignments 
in the current color table. 

Range: 

        Click the icon to open the Parametric Range dialog box. 

Level: 

        Type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style: 

        Click the icon to open the Style dialog box. 

Iso-Surface: 

        Attribute    ---    select an attribute on which to base the iso-surface from the drop-down list. 

        Value    ---    move the slider or type a value.    All values up to and including this value are used to 
create the iso-surface. 



Create Envelope
Lets you create an "envelope" graphic display for an attribute in a selected dataset.    The envelope 
surrounds all points having a constant data value plus or minus a user-defined tolerance. You adjust the 
value to be enveloped and the tolerance value to suit the selected dataset. 

The envelope surface consists of boxes generated around values that occur within the defined region.    
The surface can be boxed or bubbled.    In box mode, the surfaces of the boxes are parallel to the grid 
lines, causing the envelope surface to appear jagged.    In bubble mode, the surfaces of the boxes are 
diagonal to the grid lines, causing the envelope surface to appear bubbled. 

The coloring, interval shading, and material properties of the envelope are determined by the selected 
shading attribute and color table.    The color table can be edited by clicking Edit. 

TIP         = Graphics > Envelope (or ALT+g,v) 

SEE ALSO 
Create Envelope Dialog Box 



Create Envelope Dialog Box
Use this dialog box to select a dataset, to define the envelope shading, and to access dialog boxes for 
defining the envelope's range, the level on which to place it, and the style in which it appears. 

You also select an envelope attribute.    The geometry of the envelope is determined by the selected 
envelope attribute.    This attribute can be the same as the shading attribute, or it can be a different 
attribute. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute controls shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you edit the color/data value assignments 
in the current color table. 

Range: 

        Click the icon to open the Parametric Range dialog box. 

Level: 

        Type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style: 

        Click the icon to open the Style dialog box. 

Envelope: 

        Attribute    ---    select an envelope attribute.    The geometry of the envelope is based on the geometry 
of this attribute. 

        Tolerance    ---    type a tolerance.    This value can be a negative number. 

        Value    ---    move the slider or type a value.    This value plus or minus a tolerance value defines the 
region to be enveloped. 

        Surface Mode: 

                Bubble    ---    generates an envelope surface that appears bubbled. 

                Box    ---    generates a jagged envelope surface. 



Create Iso-Parametric
Lets you create an IJK parametric surface through a selected dataset.    An iso-parametric shows any data 
in the selected attribute that is intercepted by the surface.    This graphic display differs from a cutting 
plane in that the iso-parametric follows the IJK parametric axes of the selected dataset rather than cutting 
through grid layers. 

The coloring, interval shading, and material properties of the data are determined by the selected shading 
attribute and color table. The color table can be edited by clicking Edit. 

TIP         = Graphics > Iso-Parametric (or ALT+g,p) 

SEE ALSO 
Create Iso-Parametric Dialog Box 



Create Iso-Parametric Dialog Box
Use this dialog box to select a dataset, to define the iso-parametric shading, and to access dialog boxes for 
defining the iso-parametric range, the level on which to place it, and the style in which it appears.    You 
also select a parametric axis and a value for the axis to suit the selected dataset. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute controls shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you edit the color/data value assignments 
in the selected color table. 

Range: 

        Click the icon to open the Parametric Range dialog box. 

Level: 

        Type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style: 

        Click the icon to open the Style dialog box. 

Iso-Parametric: 

        Axis (i, j, k)    --- select a parametric axis. 

        I, J, K    --- move the slider or type a value to adjust the I, J, or K parameter value.    (The active axis is 
determined by the Axis check box.) 



Create Cap
Lets you create a bounded iso-parametric cross section of an iso-solid.    This section displays areas of 
constant data value bounded by two selected attribute values. 

The coloring, interval shading, and material properties of the area bounding the caps are determined by 
the selected shading attribute and color table.    The color table can be edited by clicking Edit. 

TIP         = Graphics > Cap (or ALT+g,a) 

SEE ALSO 
Create Cap Dialog Box 



Create Cap Dialog Box
Use this dialog box to select a dataset, to define the cap shading, and to access dialog boxes for defining 
the cap's parametric range, the level on which to place it, and the style in which it appears. 

You select a cap attribute.    The geometry of the bounded areas is determined by the selected cap 
attribute.    This attribute can be the same as the shading attribute.    You also select a parametric axis, a 
value for the axis, and a value range (low and high) for the caps. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute controls shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you edit the color/data value assignments 
in the selected color table. 

Cap: 

        Position: 

                Axis (I, J, K) ---    select a parametric axis. 

                I, J, K    ---    move the slider or type a value to adjust the I, J, or K parameter. (The active axis is 
determined by the Axis option.) 

Values: 

        Attribute    ---    select an attribute on which to base the bounding iso-parametric plane from the drop-
down list. 

        Low, High    ---    move the sliders or type values to adjust the minimum/maximum values bounding 
the iso-parametric plane. 



Create Cutting Plane
Lets you create a cutting plane through a selected dataset.    A cutting plane shows any data in the selected 
attribute that is intercepted by the surface of the plane.    This graphic display differs from an iso-
parametric graphic display in that the cutting plane cuts through layers of the selected dataset rather than 
following the grid lines. 

The coloring, interval shading, and material properties of the cutting plane are determined by the selected 
shading attribute and color table.    The color table can be edited by clicking Edit. 

TIP         = Graphics > Cutting Plane (or ALT+g,l) 

SEE ALSO 
Create Cutting Plane Dialog Box 



Create Cutting Plane Dialog Box
Use this dialog box to select a dataset, to define the cutting plane shading, and to access dialog boxes for 
defining the cutting plane's parametric range, the level on which to place it, and the style in which it 
appears. 

You also define the distance to display the plane from the center of the selected dataset.    You can also 
adjust the pitch (angular position relative to the vertical axis) and yaw (angle of rotation about the vertical 
axis relative to a fixed horizontal reference direction) of the plane. 

Dataset    ---    select a dataset from the drop-down list. 

Shading: 

        Attribute    ---    select an attribute from the drop-down list.    This attribute controls shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Color Table dialog box, which lets you edit the color/data value assignments 
in the selected color table. 

Range: 

        Click the icon to open the Parametric Range dialog box. 

Level: 

        Type a level number (1 - 63) or click the icon to open the Single-Level Selection dialog box.  

Style: 

        Click the icon to open the Style dialog box. 

Cutting Plane: 

        NOTE        Distance, pitch, and yaw are illustrated in the cutting plane diagram. 

        Distance    ---    move the slider or type a number.    Distance is the percentage distance (expressed as a 
decimal) that the plane will be displayed relative to the center of the dataset.    The range is -1.00 to 1.00. 

        Pitch    ---    move the slider or type a number. Pitch is the degree of tilt relative to the vertical axis. 
The range is -90 to 90 degrees. 

        Yaw    ---    rotate the hand of the dial or type a number.    Yaw is the degree of rotation relative to the 
horizontal axis.    The range is 0 to 360 degrees. 



Change Mode Submenu
Change Mode Shaded 
Change Mode Wireframe 
Change Mode Sketch



Change Mode Shaded
Changes the display to shaded mode. 



Change Mode Wireframe
Changes the display to wireframe mode. 



Change Mode Sketch
Changes the display to sketch mode. 



Set Active
Lets you activate a selected dataset and/or a graphic display.    You can also delete a dataset, delete a 
graphic display, or edit a graphic display. 

NOTE        Deleting a dataset removes it from the current session; it does not permanently delete the 
dataset file. 

To activate or delete volume (gridded) data or points (sample or source-point) data, you must have loaded 
that data using the appropriate File > Open command.    To activate or delete irregular volume data, you 
must have created an irregular dataset using Irregular Volume. 

To activate, edit, or delete a graphic display of a gridded dataset or of a sample point dataset, you must 
have created a graphic display using the appropriate Graphics command. 

IMPORTANT        Irregular volumes cannot be saved as HDFs, so you cannot display them using a Graphics 
command.    However, if you have created irregular volume graphic displays using Irregular Volume, you 
can activate or delete them like other graphic displays by using Set Active. 

Set Active Dialog Box 



Set Active Dialog Box
Use this dialog box to select a dataset and/or a graphic display to set active, to edit, or to delete. 

Dataset: 

        Select a dataset from the drop-down list.    By default, if more than one dataset is open, the active 
dataset is listed first. 

        Delete    ---    opens a confirmation dialog box that prompts you to confirm or cancel the deletion of 
the selected dataset. 

Graphics: 

        Select a graphic display from the drop-down list.    By default, if more than one graphic display has 
been created, the active graphic display is listed first. 

        Edit    ---    functions the same as Edit (Graphic).    You can select a different graphic display from the 
list to activate it. 

        Delete    ---    deletes the selected graphic display. 



Edit (Graphic)
Lets you edit the display parameters of the active graphic display (or of the graphic display that was 
created last, if an active display has not been set).    The editable parameters depend on the active graphic 
display. 

NOTE        You can set the active graphic display by using Set Active , which also provides an Edit button 
that functions the same as Edit (Graphic). 

The dialog boxes used to create graphic displays are the same as the dialog boxes used to edit them. For 
example, if the active graphic display is a "chair," the Create Chair dialog box appears when you select 
Graphics > Edit.    (If an active graphic display has not been set, the dialog box that corresponds to the 
graphic display that was created last appears.) 



Delete (Graphic)
Deletes the active graphic display.    If an active graphic display has not been set, the graphic displays are 
deleted in the reverse order in which they were created.    That is, the graphic display that was created last 
is deleted first. 

NOTE        You can set the active graphic display by using Set Active , which also provides a Delete button 
that functions the same as Delete (Graphic). 

When you select Graphic > Delete, a confirmation box appears. Click OK to delete either the active 
graphic display or the graphic display that was created last. 



View Control Menu
Perspective On/Off 
Front 
Back 
Top 
Bottom 
Left 
Right 
Iso+ 
Iso- 
Fit Dataset 
Fit All 
Dynamics 
Levels 
Vantage Point 
Target 
Lighting 
Z Scale 
Design Elements

TIP         turns on the View Control bar.



Perspective On/Off
Toggles perspective and orthogonal views in the active Voxel Analyst view. 

TIP         = View Control > Perspective (or ALT+v,p) 



Front
Changes the view in the active Voxel Analyst view to Front view. 

TIP         = View Control > Front (or ALT+v,f) 



Back
Changes the view in the active Voxel Analyst view to Back view (rotated 180 degrees about the Z axis). 

TIP         = View Control > Back (or ALT+v,b) 



Top
Changes the view in the active Voxel Analyst view to Top view. 

TIP         = View Control > Top (or ALT+v,t) 



Bottom
Changes the view in the active Voxel Analyst view to Bottom view (rotated vertically 180 degrees about 
the X or Y axis). 

TIP         = View Control > Bottom (or ALT+v,o) 



Left
Changes the view in the active Voxel Analyst view to Left view (rotated +90 degrees about the Z axis). 

TIP         = View Control > Left (or ALT+v,l) 



Right
Changes the view in the active Voxel Analyst view to Right view (rotated -90 degrees about the Z axis). 

TIP         = View Control > Right (or ALT+v,r) 



Iso+
Changes the view in the active Voxel Analyst view to Isometric (+) view.      (Places the vantage point in 
the positive X, positive Y, and positive Z quadrent.)

TIP         = View Control > Iso+ (or ALT+v,i) 



Iso-
Changes the view in the active Voxel Analyst view to Isometric (-) view.      (Places the vantage point in 
the negative X, negative Y, and positive Z quadrent.) 

TIP         = View Control > Iso- (or ALT+v,s) 



Fit Dataset
Fits the active dataset within the bounds of the active Voxel Analyst view. 

TIP         = View Control > Fit Dataset (or ALT+v,d) 



Fit All
Fits all design elements and open datasets within the bounds of the active Voxel Analyst view. 

TIP         = View Control > Fit All (or ALT+v,a) 



View Dynamics
Opens the Dynamics dialog box.    You control the horizontal and vertical rotation and the zoom (in/out) 
speed and turn dynamics on or off. 

TIP         = View Control > Dynamics (or ALT+v,y) 

SEE ALSO 
Dynamics Dialog Box 



Dynamics Dialog Box
Use this dialog box to turn on dynamics and to adjust dynamics parameters.    If dynamics is turned on, 
you can make adjustments interactively. 

Dynamics    ---    turns on dynamics. 

Horizontal Rotation: 

        Move the slider or type a value (as a percent of 100) for horizontal rotation. 

Vertical Rotation: 

        Move the slider or type a value (as a percent of 100) for vertical rotation. 

Zoom Speed: 

        Move the slider or type a value (as a percent of 100) for zoom speed.    This setting controls the speed 
at which the image zooms in and out. 



Levels
Lets you turn levels on/off in the active Voxel Analyst view.    A total of 63 levels are available. 

TIP         = View Control > Levels (or ALT+v,v) 

SEE ALSO 
Multi-Level Selection Dialog Box 



Vantage Point
Lets you adjust the viewing position of the graphic display(s) in the active Voxel Analyst view. 

TIP         = View Control > Vantage Point (or ALT+v,n) 

SEE ALSO 
Vantage Point Dialog Box 



Vantage Point Dialog Box
Use this dialog box to set the azimuth, declination, distance, and field of view settings.    The graphic 
display(s) adjust interactively. 

Azimuth    ---    type the degrees of azimuth (0 to 359), or press and hold the mouse Data button on the dial 
and move the dial. 

Declination    ---    move the slider or type the degrees of declination (-180 to +180). 

Distance (Unit Range)    ---    move the slider or type the distance between you and the graphic display 
(0.1 to 10.0 times the display size). 

Field of View (Degrees)    ---    move the slider or type the degrees of field of view (1 to 179). 



Target
Lets you adjust the angle of view according to a selected target point.    Click a point in the view you want 
to select the target point.    Select the command again to exit. 

TIP         = View Control > Target (or ALT+v,g) 



Lighting
Lets you specify the direction from which a graphic display is illuminated. 

Click a point in the view you want to locate the direction from which the light originates.    The graphic 
display is redrawn to show the lighting effect.    Select the command again to exit. 

TIP         = View > Lighting (or ALT+v,h) 



Z Scale
Lets you modify the Z scale (vertical exaggeration) of graphic displays. 

TIP         = View Control > Z Scale (or ALT+v,z) 

SEE ALSO 
Z Scale Dialog Box 



Z Scale Dialog Box
Use this dialog box to adjust the Z scale. 

Current Z Scale    ---    type a new Z scale. 



Design Elements
Toggles the display of imported design elements in the active Voxel Analyst view. 

TIP         = View Control > Design Elements (or ALT+v,e) 



Analyze Menu
Surface Area 
Volume 
Irregular Volume 
Statistics 
Crossplot 
Probe



Surface Area
Calculates the surface area of a selected iso-surface in the current dataset. 

TIP        Analyze > Surface Area = ALT+a,a 

SEE ALSO 

Surface Area Dialog Box 



Surface Area Dialog Box
Use this dialog box to define an iso-surface for a surface area calculation.    You select an attribute and a 
value.    The iso-surface consists of the data that occur at the selected value. 

You can further limit the surface area calculation to a portion of the dataset by adjusting the IJK 
parametric range (minimum and maximum values).    An additional attribute can be selected for area-
aggregate calculation.    The aggregate attribute can be the same as the iso-surface attribute. 

Dataset    ---    displays the current dataset name. 

Iso-Surface: 

        Attribute    ---    select an iso-surface attribute from the drop-down list. 

        Value    ---    move the slider or type a value.    This value determines the data in the iso-surface. 

Parametric Range: 

        Click the icon to open the Parametric Range dialog box. 

Results: 

        Aggregate    ---    includes an additional attribute into the surface-area calculation.    The mathematical 
equivalent of the area-aggregate calculation corresponds to a surface-integration of the aggregate attribute 
over an iso-surface. 

        NOTE        See "Data Analysis" in the Voxel Analyst Users Guide for more information on the 
implementation of the surface area calculation,

        Calculate    ---    calculates the surface area.    If the Aggregate check box is selected, calculates the 
surface area and the aggregate area simultaneously. 

        +    ---    adds the current area and aggregate area to the cumulative totals. 

        -    ---    subtracts the current area and aggregate area from the cumulative totals. 

        Clear    ---    clears the Area Cumulative and Aggregate Cumulative text fields. 

        Area: 

                Current    ---    displays the calculated area. 

                Cumulative    ---    displays the calculated cumulative area. 

Aggregate: 

        Attribute    ---    select an attribute for the area-aggregate calculation from the drop-down list. 

        Current    ---    displays the calculated aggregate area. 

        Cumulative    ---    displays the calculated cumulative aggregate area. 



Volume
Lets you calculate a volume within the current dataset. 

TIP        Analyze > Volume = ALT+a,v 

SEE ALSO 

Volume Dialog Box 



Volume Dialog Box
Use this dialog box to set up the limits of a volume calculation by defining a bounding iso-surface that is 
composed of a bounding attribute and a value.    You can calculate the volume in which the bounding 
attribute value is greater than or less than the bounding iso-surface value. 

You can further limit the volume calculation by adjusting the IJK parametric range (minimum and 
maximum values).    An additional attribute can be selected for volume-aggregate calculation.    The 
aggregate attribute can be the same as the bounding attribute. 

TIP        The results of the volume calculation (the quantity shown in the Volume area) represents the total 
amount of, for example contaminant that is greater than or less than the bounding surface that defines the 
volume. 

Dataset    ---    displays the current dataset name. 

Iso-Surface Bounding: 

        Greater Than    ---    calculates the volume in which the bounding attribute value is greater than the 
iso-surface bounding value. 

        Less Than    ---    calculates the volume in which the bounding attribute value is less than the iso-
surface bounding value. 

        Attribute    ---    select an attribute for the volume calculation from the drop-down list. 

        Value    ---    move the slider or type a value.    This value and the iso-surface bounding attribute define 
the bounding iso-surface. 

Parametric Range: 

        Click the icon to open the Parametric Range Dialog Box 

Results: 

        Aggregate    ---    includes an additional attribute in the volume calculation.    The mathematical 
equivalent of the volume-aggregate calculation corresponds to a volume-integration of the aggregate 
attribute over a volume. 

        NOTE        See Data Analysis in the Voxel Analyst Users Guide for more information on the 
implementation of the volume calculation. 

        Calculate    ---    calculates the volume.    If the Aggregate check box is selected, calculates the volume 
and the aggregate volume simultaneously. 

        +    ---    adds the current volume and aggregate volume to the cumulative totals. 

        -    ---    subtracts the current volume and aggregate volume from the cumulative totals. 

        Clear    ---    clears the Volume Cumulative and Aggregate Cumulative text fields. 

        Volume: 

                Current    ---    displays the calculated volume. 

                Cumulative    ---    displays the calculated cumulative volume. 

Aggregate: 

        Attribute    ---    select an attribute for the volume-aggregate calculation from the drop-down list. 

        Current    ---    displays the calculated aggregate volume. 

        Cumulative    ---    displays the calculated cumulative aggregate volume. 



Irregular Volume
Lets you calculate irregular volumes within the current dataset. You set up the limits of the calculations by 
defining multiple-bounding surfaces, letting you perform Boolean volume calculations.    The resulting 
graphic display can be rotated, snapshot, or printed. 

TIP        Analyze > Irregular Volume = ALT+a,i 

SEE ALSO 

Irregular Volume Dialog Box 



Irregular Volume Dialog Box
Use this dialog box to select a shading attribute and color table and to define the bounding surfaces.    The 
bounding surfaces can be planes or other iso-surfaces. 

If the bounding surface is a plane, define the pitch, yaw, and distance of the plane.    You can calculate the 
volume above (Top) the plane or the volume below (Bottom) the plane.    (Depending on how the dataset 
is oriented, a volume above the plane may appear in graphics to be below the plane, and vice versa.) 

If the bounding surface is an iso-surface, select a bounding attribute and value, similar to a bounding 
attribute and value you select for calculating a regular volume.    You can calculate the volume in which 
the bounding attribute value is greater than or less than the iso-surface value, similar to calculating a 
regular volume. (Depending on how the dataset is oriented, a volume that is intended to be greater than 
the bounding iso-surface may appear in graphics to be less than the bounding iso-surface, and vice versa.) 

An additional attribute can be selected for irregular-volume aggregate calculation.    The aggregate 
attribute can be the same as the shading attribute or it can be the same as the bounding attribute. 

TIP        The results of the irregular volume calculation (the quantity shown in the Volume area) represents 
the total amount of, for example contaminant that is top/bottom of or greater than/less than the bounding 
iso-surface that defines the irregular volume. 

Dataset    ---    displays a default dataset name (Irreg<number>), which becomes the current dataset. 

Display Parameters: 

        Shading Attribute    ---    select an attribute from the drop-down list.    This attribute controls shading. 

        Color Table    ---    select a color table from the drop-down list, which shows the color tables in the 
current color table (CTR) file. 

        Edit    ---    opens the Edit Colors dialog box, which you use to edit the color/data value assignments in 
the current color table. 

        Level    ---    type a level number (1 - 63), or click the icon to open the Single-Level Selection dialog 
box. 

        NOTE        It is recommended that you select a level such that the irregular volume appears in a 
different view than the active graphic display. 

Bounding Parameters: 

        Plane    ---    lets you define parameters for a planar bounding surface. 

        Iso-Surface    ---    lets you define parameters for an iso-surface bounding surface. 

        NOTE        Top, Bottom, Pitch, Yaw, and Distance appear only when Plane is selected. 

        Top    ---    creates a volume top of the plane. 

        Bottom    ---    creates a volume bottom of the plane. 

        Pitch    ---    move the slider or type a number.    Pitch is the degree of tilt relative to the vertical axis.    
The range is -90 degrees to +90 degrees. 

        Yaw    ---    move the slider or type a number.    Yaw is the degree of rotation relative to the horizontal 
axis.    The range is 0 to 360 degrees. 

        Distance    ---    move the slider or type a number.    Distance is the percentage distance (expressed as a 
decimal) that the plane appears relative to the center of the dataset.    The range is -1.00 to 1.00. 

        NOTE        Greater Than, Less Than, Attribute, and Value appear only when Iso-Surface is selected. 

        Greater Than    ---    creates volume in which the bounding attribute value is greater than the iso-



surface bounding value. 

        Less Than    ---    creates volume in which the bounding attribute value is less than the iso-surface 
bounding value. 

        Attribute    ---    select a bounding attribute from the drop-down list. 

        Value    ---    move the slider or type a value.    All values up to and including this value are used to 
create the bounding iso-surface. 

        Execute    ---    creates a volume based on the current bounding surface. 

        Undo Last    ---    undoes the last volume created. 

        Undo All    ---    undoes all the volumes created in the current use of the command.

Results: 

        Aggregate    ---    lets you include an additional attribute with the volume calculation. 

        Calculate    ---    calculates the volume.    If the Aggregate check box is selected, calculates the volume 
and the aggregate volume simultaneously. 

        +    ---    adds the current volume and the aggregate volume to the cumulative totals. 

        -    ---    subtracts the current irregular volume and aggregate irregular volume from the cumulative 
totals. 

        Clear    ---    clears the Volume Cumulative and Aggregate Cumulative text fields. 

        Volume: 

                Current    ---    displays the calculated volume. 

                Cumulative    ---    displays the calculated cumulative volume. 

        Aggregate: 

                Attribute    ---    select an aggregate attribute from the drop-down list. 

                Current    ---    displays the calculated aggregate volume. 

                Cumulative    ---    displays the calculated cumulative aggregate volume. 



Statistics
Calculates the minimum, maximum, mean, median, standard deviation, and variance of a selected 
attribute within the current dataset, and draws a histogram showing the frequency distribution of the data. 

NOTE        Statistics and Probe are particularly useful for evaluating and analyzing data early in the 
analysis workflow. 

Each bar of the histogram corresponds to an interval of the active dataset.    The bar's color is determined 
by the current color table. You can take a snapshot of a histogram by using Snapshot Fenced Area. 

TIP        Analyze > Statistics = ALT+a,s 

SEE ALSO 

Statistics Dialog Box 



Statistics Dialog Box
Use this dialog box to select a dataset, an attribute, and a color table, and to specify the number of 
intervals to be used to calculate statistics and to draw the histogram. 

Optionally, you can adjust the histogram minimum/maximum values and redraw it based on those values. 
You can also read the number of values and the range (minimum/maximum values) in an interval by 
selecting the corresponding bar on the histogram. 

Dataset    ---    select a dataset from the drop-down list. 

Attribute    ---    select an attribute from the drop-down list. 

Color Table    ---    select a color table from the drop-down list. 

Intervals    ---    type the number of intervals.    By default, the number of intervals is 50. 

Calculate    ---    calculates the dataset statistics using the minimum and maximum values in the Minimum 
and Maximum text fields, respectively. 

Minimum    ---    displays the minimum value in the data distribution by default. 

Maximum    ---    displays the maximum value in the data distribution by default. 

Mean    ---    displays the mean.    The mean value represents the middle point between the minimum and 
maximum data values. 

Median    ---    displays the median.    The median is the value below and above which there is an equal 
number of values or which is the arithmetic mean of the two middle values if there is no one middle 
number. 

Std. Dev.    ---    displays the standard deviation.    Standard deviation is a measure of the dispersion of a 
frequency distribution. 

Variance    ---    displays the variance. Variance is the square of the standard deviation. 

Histogram: 

        Minimum    ---    displays the histogram minimum value and lets you adjust the minimum value. 

        Maximum    ---    displays the histogram maximum value and lets you adjust the maximum value. 

        NOTE        The histogram is a graph that plots the number of values (Frequency) versus the values in 
each interval of the histogram range (Values). 

Report    ---    opens the Save As dialog box , which lets you save the statistics to a report file. 



Crossplot
Lets you plot two attributes in the current dataset against each other using color as the third dimension.    
When the data type is point, you can select data points from the crossplot and create a Voxel Analyst 
graphic display for the selected data.    This lets you correlate the crossplotted data with its orginal 
location within the current dataset.    The resulting graphic display can be edited and manipulated like 
other point-data graphic displays. 

TIP        Analyze > Crossplot = ALT+a,c 

SEE ALSO 

Crossplot Dialog Box 



Crossplot Dialog Box
Use this dialog box to select a dataset, an X-axis attribute, a Y-axis attribute, a color field, and a color 
table.    (The coloring, interval shading, and material properties of the point data are determined by the 
current color field and color table.) 

Clicking Hilite lets you fence the points for which you want to create a graphic display.    Clicking OK 
creates the graphic display in the view without altering the parameters on the Crossplot dialog box.    
Clicking Hilite again (without clicking OK) lets you fence a different set of points without placing them 
in graphics. 

Dataset    ---    select a dataset from the drop-down list. 

X    ---    select an X-axis attribute.    By default, the active attribute appears. 

Y    ---    select a Y-axis attribute.    By default, the active attribute appears. 

Color Field    ---    select a color field.    By default, the active attribute appears.    This is the field on which 
color is based. 

Color Table    ---    select a color table.    By default, the first color table in the current CTR file appears. 

OK    ---    creates the graphic display, leaves it in memory as part of the current session, and dismisses the 
dialog box. 

Apply    ---    creates the graphic display, leaves it in memory as part of the current session, and keeps the 
dialog box open. 

Cancel    ---    dismisses the dialog box without altering the graphic displays already created (if any). 

Crossplot: 

        Displays the crossplot diagram.    You can see the values at each XY coordinate by moving the pointer 
over the diagram. 

Plot    ---    creates a crossplot based on the X and Y attributes. 

Window Area    ---    lets you zoom in on a fenced area of the crossplot.    Press and hold the mouse Data 
button and drag the pointer to include the area you want to zoom; then release the button. 

Reset    ---    resets the crossplot window to the original crossplot diagram. 

Hilite    ---    lets you fence data points on the crossplot.    The corresponding source points appear as a 
highlighted cube in the view. 

Save As    ---    opens the Save As dialog box , which lets you save the fenced data points (inside or 
outside) to a file. 



Probe
Lets you probe the active dataset using I, J, and K grid lines as a reference. 

TIP        Analyze > Probe = ALT+a,p 

SEE ALSO 

Probe Dialog Box 



Probe Dialog Box
Use this dialog box to select a dataset, to display the XYZ coordinate values for each point in the dataset, 
and to display the value for each data field. 

Dataset    ---    select a dataset from the drop-down list. 

Plane: 

        I, J, K    --- select one of these options to define the parametric plane for the pointer. 

I, J, K    ---    adjust these sliders to control the 3-D pointer and to select a point in the current dataset. 

X, Y, Z    ---    display the XYZ coordinates for the selected point. 

Attribute    ---    displays the attributes in the current dataset. 

Value    ---    displays the value for the selected point in each attribute. 



Utilities Menu
Working Units 
Preferences 
Convert Submenu 
Snapshot Submenu 
Stereo Submenu 
Report File



Working Units
Lets you load working units to Voxel Analyst or define working units for a Voxel Analyst session. 

TIP        Utilities > Working Units = ALT+u,w 

SEE ALSO 

Working Units Dialog Box 



Working Units Dialog Box
Use this dialog box to load working units from a file, such as an AutoCad file or a MicroStation design 
file, or to define your own values for working-unit parameters, such as XY units, XY UORs (units-of-
resolution), and XYZ origin. 

Load from File    ---    lets you load working units from a file.    Click Browse and select a file from the 
Open dialog box.

Define Working Units    ---    enables Working Unit Parameters so that you can define your own working 
units. 

Working Unit Parameters: 

        XY Units    ---    type the units for the XY dimensions.    By default, the XY units is ft (feet). 

        Z Units    ---    type the units for the Z dimension.    By default, the Z units is ft (feet). 

        XY UORs    ---    type the units-of-resolution for the XY dimensions.    By default, the XY UORs is 
100. 

        Z UORs    ---    type the units-of-resolution for the Z dimension. By default, the Z UORs is 100. 

        X Origin    ---    type an origin value for the X dimension.    By default, the X origin is 0 (zero). 

        Y Origin    ---    type an origin value for the Y dimension.    By default, the Y origin is 0 (zero). 

        Z Origin    ---    type an origin value for the Z dimension.    By default, the Z origin is 0 (zero). 



Preferences
Lets you set preferences for the Voxel Analyst environment. 

TIP         = Utilities > Preferences (or ALT+u,p) 

SEE ALSO 
Preferences Dialog Box 



Preferences Dialog Box
Use this dialog box to set preferences, such as graphics caching, background color, and lighting effects. 

NOTE        All preferences and view positions are saved in the registry.

View Axis    ---    turns on the XYZ axis to help you orient the graphic displays in each Voxel Analyst 
view. 

Graphics Caching    ---    caches the entire graphics display. 

NOTE        When Graphics Caching is on, calls to the graphic library for the entire graphic display are 
stored in memory.    Therefore, it is recommended that you turn off graphics caching when using larger 
datasets. 

Precision    ---    type the precision you want for data values. 

Backing Store    ---    stores graphic displays as bitmaps so that when the Voxel Analyst view is covered by 
another window or a view is iconified and restored, the displays are not lost.

Colors: 

        Background    ---    opens the Adjust Color dialog box , which lets you define a background color.    By 
default, background color is black. 

        Sketch    ---    opens the Adjust Color dialog box , which lets you define a color for graphic displays in 
sketch mode.    By default, sketch color is yellow. 

Lighting: 

        One-Sided    ---    turns on exterior lighting only.    This option is good to use when creating chair, 
solid, and source-point graphic displays. 

        Two-Sided    ---    turns on interior and exterior lighting.    This option is good to use when creating 
iso-solid, iso-parametric, envelope, and cutting-plane graphic displays. 

Front Viewing: 

        X-Z Plane    ---    rotates the front viewing plane to emulate the front view of a MicroStation design 
file. 

        Y-Z Plane    ---    rotates the front viewing plane 180 degrees about the Z axis from the X-Z plane to 
emulate the front view of a standard CAD drawing. 

Lighting Effects: 

        Activate    ---    enables the Lighting Effects area, letting you define parameters for lighting effects. 

        NOTE        When Lighting Effects is on, objects appear foggy. 

        Color    ---    opens the Adjust Color dialog box , which lets you define a color for lighting effects.    
By default, lighting effects color is black. 

        Scales: 

                Front    ---    move the slider, or type a value to set the front scale factor.    By default, the front 
scale factor is set at 100% object color (expressed as a decimal). 

                Back    ---    move the slider, or type a value to set the back scale factor.    By default, the back 
scale factor is set at 0% object color (expressed as a decimal) and maximum lighting effect. 

                NOTE        Define the lighting effects color and adjust the front and back scale factors to suit your 
dataset.    When the front and back scale factors are set to zero, the object appears in the lighting effects 
color.    When the front and back scale factors are set to 1.0, no lighting effects color appears. 



Convert Submenu
Convert Sparse Data to Volume Data 
Convert Volume to ASCII 
Convert ASCII to Volume



Convert Sparse Data to Volume Data
Converts sparsely or irregularly distributed data values, such as borehole sample points, to a 3-D volume 
dataset that can be input into Voxel Analyst.    The data is interpolated according to a set of parameters that 
you define as follows: 

· Input/output files

· Output dataset minimum bounding volume (MBV) 
· Output data field names, units, and optional clipping values 
· Interpolation methods (algorithms) 
· Interpolation restrictions 
· Variation enhancement values 

TIP        Utilities > Convert > Sparse to Volume = ALT+u,c,s 

SEE ALSO 

Convert Sparse Data to Volume Data Dialog Box 
Working Units Dialog Box 
Interpolation Parameters Dialog Box



Convert Sparse Data to Volume Data Dialog Box
Use this dialog box to set up a variety of parameter configurations for converting sparse data.    For 
example, you can interpolate single or multiple attributes and output them into a single volume.    You can 
clip data values according to user-defined minimum and maximum limits.    You can define the bounding 
limits and the dimensions of the output dataset. 

TIP        You can use the last-used parameters, or you can modify the last-used parameters, or you can clear 
all the parameters and define new ones. 

Files: 

        Parameters    ---    type an interpolation parameters (.par) file name, or click Parameters and select 
a .par file from the Open dialog box. 

        NOTE        The first time Convert Sparse Data to Volume Data is used, the default parameter file is 
sp2vol.par.    This file is initially empty.    If you do not type a different file name, the current parameters 
are saved to sp2vol.par when you click Save.    The next time the command is used, the last-used 
parameters automatically appear on the dialog box.    If you do not want to use these parameters, click 
Clear and select a different parameter file, or define new parameters. 

        Geometry    ---    type an .hdf file name to use as the geometry file for the interpolation, or click 
Geometry and select an .hdf file from the Open dialog box. 

        NOTE        If you select an existing .hdf file, the output data is interpolated over the geometry from that 
file and the geometry is copied into the output file. 

        Output    ---    type an .hdf file name to store the output dataset, or click Output and select an .hdf file 
from the Open dialog box. 

        Save    ---    saves the current parameters to the file name in the Parameters text box. 

        Clear    ---    clears the current parameters from the dialog box. 

        Overwrite    ---    overwrites the current output file with the new data. 

        Append    ---    adds the new volume data to the output dataset in the Output text box. 

Output Dataset: 

        Name    ---    type an output dataset file name. 

        Grid K(X)|J(Y)|I(Z)    ---    displays the number of grid nodes in each parametric direction (I,J,K) of 
the output dataset, and lets you type different grid-node values.    By default, the dimensions are 
10x10x10. 

        Minimum Bounding Volume: 

                User Specified    ---    lets you customize the minimum bounding volume of the output dataset.    
Type the XYZ minimum/maximum values in the Range area. 

                Computed    ---    calculates the minimum bounding volume of the output dataset. 

        Ranges    ---    displays the XYZ minimum/maximum values that define the minimum bounding 
volume of the output dataset. 

        Working Units    ---    opens the Working Units dialog box. 

Attributes: 

        Browse    ---    opens the Open dialog box , which lets you select an input sample points (.smp) file. 

        TIP        This is the source points file you imported using Import Source Points. 



        Delete    ---    deletes a selected entry in the Input File Name|Col|Points text box. 

        File Name|Col|Points    ---    display the imported .smp file name that contains the data to be 
converted, the number of columns in the file, and the number of sample points in each column. 

        Name    ---    type the name of the output attribute. 

        Units    ---    type the units of the output attribute. 

        Clip Min    ---    turns on clipping of the output data at the value shown in the Clip Min text box. 

        Clip Max    ---    turns on clipping of the output data at the value shown in the Clip Max text box. 

        Default    ---    resets the clip minimum and maximum values to the default values. 

        Interpolation Parameters    ---    opens the Interpolation Parameters dialog box. 

Reset    ---    resets the parameters to the last-used parameters. 



Interpolation Parameters Dialog Box
Use this dialog box to select optional interpolation restrictions and variation enhancement values.    You 
can set up interpolation parameters in advance before importing sample (source) point data. These 
parameters then become the default parameters for any source points subsequently imported. 

Variation enhancement is important for interpolating flat output volume that has a much smaller Z range 
compared to the X,Y ranges. Without variation enhancement, the output interpolated values would show 
very little variations along the Z direction.    This is because the interpolation methods provided in Voxel 
Analyst are distance-based methods in which a small Z range contributes little weight to the interpolation 
compared to the larger X,Y ranges.    The calculated variation enhancement values are computed such that 
the small Z range provides the same contribution to the interpolation as the large X,Y ranges. 

TIP        You can use the last-used interpolation parameters, or you can modify the parameters, or you can 
select a different algorithm and define new parameters. 

Method: 

        Select an interpolation method from the drop-down list as follows: 

· Metric    ---    a powered inverse-distance weighted approximation that can be used for very rough and 
unevenly distributed input data.    The output values are bounded by the range of the input data values. 

          Parameters: 

          The power parameter defines how much each input data value affects the values of its nearby 
output points.    A power of ten is considered to be large, while a power less than one is considered to be 
small.    (Small power is not recommended.) The power cannot be less than zero. 

          The background parameter is the value that the output values fade into when they are 
extrapolated. 

          The influence range parameter is a positive number that controls the distance at which the output 
values start fading.    (The influence distance is the influence range times the diameter of the minimum 
bounding sphere of the input data points.)    An influence range of 0.1 is considered small, while an 
influence range of 10 is considered large.    An influence range of 0 turns off the control.    When this 
happens, the extrapolated output values fade into the average value of the input data. 

· Multiquadric    ---    a second-order interpolation method that can be used for input data that is 
relatively smooth and relatively evenly distributed.    This method produces smooth varying output 
data.    However, the extrapolated output values may not be bounded. It is highly recommended that 
you turn the Clip Min and Clip Max check boxes (on the Convert Sparse Data to Volume Data dialog 
box) on to clip the output values to a physically realistic range. 

          Parameters: 

          The variance parameter is used to enhance the variations in the output data.    Valid input is any 
non-negative number.    However, it is not recommended to use any number that is larger than 0.5.    A 
large number could cause the interpolation to be unstable and to produce large errors. 

· Shepard    ---    an inverse-distance weighted approximation that can be used for very rough and 
unevenly distributed input data. The interpolated output values are bounded by the range of the input 
data values. 



          Parameters: 

          The background parameter is the value that the output values fade into when they are 
extrapolated. 

          The influence range parameter is a positive number that controls the distance at which the output 
values start fading.    (The influence distance is the influence range times the diameter of the minimum 
bounding sphere of the input data points.)    An influence range of 0.1 is considered small, while an 
influence range of 10 is considered large.    An influence range of 0 turns off the control.    When this 
happens, the extrapolated output values fade into the average value of the input data. 

· Thin-plate Spline    ---    used for input data that is relatively smooth and relatively evenly distributed. 
This method minimizes the curvatures in the output data.    The output values are not bounded when 
extrapolated.    It is highly recommended that you turn the Clip Min and Clip Max check boxes (on 
the Convert Sparse Data to Volume Data dialog box) on to clip the output values into a physically 
realistic range. 

· Volume Spline    ---    a generalization of the cubic splines that can be used for input data that is 
relatively smooth and relatively evenly distributed.    This method can generate smooth varying output 
volume. 

          When extrapolating, this method could extend output values beyond the input value range.    It is 
highly recommended that you turn the Clip Min and Clip Max check boxes (on the Convert Sparse Data 
to Volume Data dialog box) on to clip the output values to a physically realistic range. 

See the Voxel Analyst Users Guide for more information on interpolation methods. 

        Parameters: 

                Displays the parameters (where applicable) and the parameter values of the selected interpolation 
method.    You can modify the default values by typing different values. 

                Default    ---    resets the parameter values to the default values. 

        Apply Logarithms to Data    ---    compresses the data range to a smaller scale.    This is useful for 
handling large data ranges, for example, a range of 0 - 4 million can be compressed to a smaller range.    
The output logarithmic data cannot be converted back to non-logarithmic. 

Restrictions: 

        The following controls let you set up restrictions that are applied to the input source points during 
interpolation.    The restrictions can be combined, with the exception of the two local restriction, which 
are mutually exclusive.    (The result of a local restriction is that the output data points are centered around 
a central grid node.) 

        Use Sparse Points within MBV Only    --- interpolates only the sparse data points within the minimum 
bounding volume (MBV) defined on the Convert Sparse Data to Volume Data dialog box. 

        Apply Local Restriction    ---    enables two types of restrictions that can be applied to the input source 
points: By Percentage of MBV and By HDF File. 

        By Percentage of MBV    ---    enables the X(K), Y(J), and Z(I) text boxes. 

        X(K), Y(J), Z(I)    ---    type a local restriction as a percentage of the MBV of the input source points 
expressed as XYZ values.    Only those input values that occur within the specified XYZ are interpolated. 

        By HDF File    ---    enables the text box.    Type the name of an .hdf file to be applied as a restriction 
on the input source points.    Only those input values that occur in the selected file are interpolated. 



        Browse    ---    opens the Open dialog box , which lets you select an .hdf file for the By HDF File 
restriction. 

        Apply Symbolic Restriction    ---    enables symbolic restriction that can be applied to the input source 
points. This restriction ignores any rotation of the input source points and limits the interpolation to the 
symbolic fields defined in the input Geometry file. 

        Symbolic Field    ---    type a symbolic field to be applied as a restriction on the input source points, or 
select a symbolic field from the drop-down list. 

        Background Value    ---    type a value that will be used to create background data points for a lone 
input data point. 

Variation Enhancement: 

        Auto    ---    enables variation enhancement using the default values shown in the X(K), Y(J), and Z(I) 
text boxes. 

        Keyin    ---    type variation enhancement values in the X(K), Y(J), and Z(I) text boxes. 

        Off    ---    turns off variation enhancement. 

        X(K)    ---    type a value for the K parameter. 

        Y(J)    ---    type a value for the J parameter. 

        Z(I)    ---    type a value for the I parameter. 



Convert Volume to ASCII
Converts an HDF (Hierarchical Data Format) file to a Voxel Analyst-specific ASCII-formatted file. 

See the "MGVA_ASCII File Format" appendix in the Voxel Analyst User's Guide for a generic example of 
a Voxel Analyst-specific ASCII file.    See c:\win32app\ingr\voxel\samples\misc\sphere.asc for a specific 
example. 

TIP        Utilities > Convert > Volume to ASCII = ALT+u,c,v 

SEE ALSO 

Convert Volume to ASCII Dialog Box 



Convert Volume to ASCII Dialog Box
Use this dialog box to select an input directory and file name and an output directory and file name.    By 
default, the input and output directories are the current working directories. 

Input File Name    ---    type an input file name, or click Browse and select an input file from the Open 
dialog box. 

Output File Name    ---    type an output file name, or click Browse and select an output file from the Save 
As dialog box. 



Convert ASCII to Volume
Converts a data file in Voxel Analyst-specific ASCII format to an HDF (Hierarchical Data Format) file 
that can be loaded into Voxel Analyst.    A Voxel Analyst-specific ASCII data file is composed of a group 
of MGVA_ASCII functions that describe a dataset. 

See the "MGVA_ASCII File Format" appendix in the Voxel Analyst Users Guide for descriptions of the 
functions and a generic example of the format.    See c:\win32app\ingr\voxel\samples\misc\sphere.asc for 
an example of an MGVA_ASCII file.    See c:\win32app\ingr\voxel\samples\misc\sphere.hdf for an 
example of an HDF file. 

TIP        Utilities > Convert > ASCII to Volume = ALT+u,c,a 

SEE ALSO 

Convert ASCII to Volume Dialog Box 



Convert ASCII to Volume Dialog Box
Use this dialog box to select an input directory and file name and an output directory and file name.    By 
default, the input and output directories are the current working directories. 

Input File Name    ---    type an input file name, or click Browse and select an input file from the Open 
dialog box. 

Output File Name    ---    type an output file name, or click Browse and select an output file from the Save 
As dialog box. 



Snapshot Submenu
Snapshot Parameters 
Snapshot Active View 
Snapshot Fenced Area



Snapshot Parameters
Lets you set up parameters for taking snapshots. 

TIP        Utilities > Snapshot > Parameters = ALT+u,s,p 

SEE ALSO 

Snapshot Parameters Dialog Box 



Snapshot Parameters Dialog Box
Use this dialog box to select an output format, such as BMP, Intergraph RGB (red-green-blue raster 
image), PCX, TIFF, or Targa (a standard developed by Truevision), and an output file name (and 
directory). 

Output Format    ---    select a format type from the drop-down list. 

File Name    ---    if you do not want to use the default, type a different file name, or click Browse and 
select a file from the Save As dialog box. 

NOTE        To save a snapshot file to a directory other than the default directory, you must have created that 
directory. 

Auto Increment    ---    automatically increments the default output file name by one (1) each time you take 
a snapshot. 

Overwrite Existing File(s)    ---    overwrites an existing output file of the same name. 



Snapshot Active View
Takes a snapshot of the active Voxel Analyst view and saves it to the output file (and format) you 
specified on the Snapshot Parameters dialog box. 

TIP         = Utilties > Snapshot > Active View (or ALT+u,s,v) 

SEE ALSO 
Snapshot Parameters 



Snapshot Fenced Area
Lets you take a snapshot of the contents of a user-defined area in a Voxel Analyst view.    Press and hold 
the mouse Data button in the view you want, drag the pointer to enclose the contents you want, and then 
release the button.    The snapshot is saved to the output file (and format) you specified on the Snapshot 
Parameters dialog box. 

TIP        Utilities > Snapshot > Fenced Area = ALT+u,s,a 

SEE ALSO 

Snapshot Parameters 



Stereo Submenu
Stereo Parameters 
Stereo Display On 
Stereo Display Off



Stereo Parameters
Lets you define parameters for creating stereo displays. 

TIP        Utilities > Stereo > Parameters = ALT+u,t,p 

SEE ALSO 

Stereo Parameters Dialog Box 



Stereo Parameters Dialog Box
Use this dialog box to define a parameter for stereo displays. 

Horizontal Visual Angle    ---    move the slider or type an angle of view (0 to 8 degrees). 

Reset    ---    resets the horizontal visual angle to the last-used value. 



Stereo Display On
Turns on stereo display for the active view using the parameters you specified on the Stereo Parameters 
dialog box. 

TIP        Utilities > Stereo > Display On = ALT+u,t,d 

SEE ALSO 

Stereo Parameters 
Stereo Display Off



Stereo Display Off
Turns off stereo display in the active view. 

TIP        Utilities > Stereo > Display Off = ALT+u,t,f 

SEE ALSO 

Stereo Display On 



Report File
Lets you save the results of surface area, volume, and irregular volume calculations to a report file.    Any 
calculations you make are written to the open report file whether the dialog box is open or not.    If you 
close the report file before clicking OK, any further calculations you make are not saved to the report. 

NOTE        If you want to store report files in a directory other than the default directory, you must have 
created that directory. 

TIP        Utilities > Report = ALT+u,r 

SEE ALSO 

Report File Dialog Box 



Report File Dialog Box
Use this dialog box to open a new report file, view an existing report, close an open report file, or clear 
the contents of an open report file.    You can append results to an existing file, or you can overwrite an 
existing file with new results. 

TIP        Only one report can be open at a time. 

Open File    ---    opens the Open dialog box , which lets you select a new or existing report file. 

Close File    ---    closes the open report file. 

Clear File    ---    clears the contents of the open report file. 

File Name    ---    displays the name of the current report file. 

Append    ---    appends results of calculations to the open report file. 

Overwrite    ---    overwrites the contents (if any) of the open report file. 



Tools Menu
Toolbar 
Graphics Bar 
View Control Bar 
Utility Bar 
Status Bar 
Coordinate Bar



Toolbar
Toggles the Toolbar in the Voxel Analyst window.

TIP        Tools > Toolbar = ALT+t,t 

SEE ALSO 

View Control Menu 
Graphics Menu 
Utilities Menu



Graphics Bar
Toggles the Graphics bar in the Voxel Analyst window. Each icon in the Graphics bar corresponds to a 
graphic component command in the Graphics menu. 

TIP         = Tools > Graphics Bar (or ALT+t,g) 



View Control Bar
Toggles the View Control bar in the Voxel Analyst window. Each icon in the View Control bar 
corresponds to a viewing position command in the View Control menu. 

TIP         = Tools > View Control Bar (or ALT+t,v) 



Utility Bar
Toggles the Utility bar in the Voxel Analyst window. Each icon in the Utility bar corresponds to a 
command in the Utilities menu. 

TIP         = Tools > Utility Bar (or ALT+t,u) 



Status Bar
Toggles the status field in the Voxel Analyst window. 

TIP        Tools > Status Bar = ALT+t,s 



Coordinate Bar
Toggles the coordinate status bar in the Voxel Analyst window. 

TIP         = Tools > Coordinate Bar (or ALT+t,u) 



Window Menu

New Window

Cascade

Tile

Arrange Icons



Voxel Analyst Dictionary
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

absolute pathname
The sequence of directories, beginning with the root directory that locates a file.    See also pathname and 
relative pathname.

aggregate
The total of each voxel's average attribute value summed over the entire volume. 

ambient light
Light that emanates from all directions, and thus illuminates all surfaces equally, regardless of their 
orientation. 

ambient reflection
Light is reflected such that the source appears to be from all points surrounding the object. 

ASCII
American Standard Code for Information Interchange, a code for representing alphanumeric information. 



attribute
A collection of data values, one for every point in the dataset.    A value can be scalar, vector, or symbolic. 
See also scalar data, vector data, and symbolic data.

BMP
A bit map file. 

Back
Button on the On-line Help window that allows you to display the previous Help article. 

blended shading
A method of shading in which each color of the graphic object is blended to or from a user-defined color, 
creating a distinction from one color to the next. 

bounding volume
A data volume that surrounds an iso-solid in space. 

caching
A method of storing display data for the OpenGL graphics library in memory to reduce the time required 
to refresh graphic displays.    You can enable/disable caching by using Preferences.    Caching is not 
recommended for large datasets. 

cap
A graphic display in which an iso-parametric surface is bounded by two data field values. 

chair
A graphic display in which a corner is cut away from the dataset revealing data values within.    The 
resulting notch causes the graphic to appear like a chair. 

color table
A set of color/data value pairs and material properties used by Voxel Analyst to shade graphic displays. 

color table file (CTR)
A palette of one or more color tables. 

Contents
Button on the On-line Help window that displays the Help table of contents. 

cutting plane
A graphic display represented by a planar surface that cuts through a 3-D data volume at any orientation. 

data range
The range of data defined by a maximum value and a minimum value within a data field or an attribute. 

default
The predetermined value of a parameter that is automatically supplied by Voxel Analyst. 

delta
The difference in elevation between two grid layers. 

design file



A file containing graphic and text data.    Also called a drawing file. 

diffuse reflection
Light is reflected such that the source appears to be from one point (by default, the viewing position) 
relative to the object, brightening parts of the object that face the light and causing a 3-D appearance.    
This type of reflection aids in depth perception of the object and defines shape for the viewer. 

directory
A file that contains the names of other files. 

dynamics
A View Control command in which graphic objects can be rotated and zoomed automatically and 
continuously. 

envelope
A graphic display in which the object surface consists of boxes generated around values that occur within 
a defined region.

file
A collection of logical records stored as a unit. 

file extension
A three-letter suffix preceded by a period and appended to a file name to describe the file type or content. 

file name
A user-defined name given to an interactively created file.    The name should be relevant to the contents 
of the file. 

fit
A View Control command that expands the area seen within a Voxel Analyst view to include all graphic 
displays on all levels turned on in the view. 

frequency distribution
An arrangement of statistical data that exhibits the frequency of the occurrence of the data values. 

gloss
Surface luster or brightness. 

Glossary
Button on the On-line Help window that lets you display the Help glossary. 

Gouraud Shading
Shading based on intensity interpolation rather than normal vector interpolation.    This method of shading 
eliminates intensity discontinuities on the surfaces of graphic objects.    See also smooth shading. 

graphic display
A 3-D graphic used to visualize data in a 3-D volume.    Several types of graphic displays are available in 
Voxel Analyst ranging from a simple outline to a complex iso-solid.    Different types of graphic displays 
can be created for the active dataset in a single Voxel Analyst view, and they can be snapshot as output or 
exported as design file elements. 



GVA (session) file
A Voxel Analyst file that consists of the active dataset (including graphic displays), the active color 
table(s), the Z scale, and working unit information.    Saving the current session saves this information to a 
GVA file with a .gva file extension. 

HDF
See Hierarchical Data Format. 

help files
Online documentation that provides process descriptions and operational summaries to help you use the 
software. 

Hierarchical Data Format
A data format that Voxel Analyst uses to store datasets.    An HDF data file has an .hdf file extension. 

histogram
A graph that shows the frequency distribution of data values. 

IJK
A unique integer triplet that identifies every grid location in a 3-D volume.    A 3-D volume is defined 
using a 3-D grid.    Each data point in the volume lies on a grid-intersection.    Each grid intersection has 
the 3-D geographic coordinate X, Y, and Z associated with it.    Therefore, the coordinates of each grid-
intersection can be written as (X[I,J,K], Y[I,J,K], Z[I,J,K]), so that each X,Y,Z coordinate is a function of 
all three I,J,K integers or parameters.    You use I,J,K parameters in the creation of graphic displays:    
adjusting the parametric ranges (the minimum and maximum I, J, and K values) in graphics displays 
allows you to evaluate and analyze data variation. 

identity matrix
A dataset matrix (a 4 x 4 array of numbers) in which any rotation, scaling, or translation has been 
removed.    In Voxel Analyst, you use Identity Dataset to set the current dataset orientation matrix to the 
identity matrix. 

irregular grid
A 3-D grid in which spacing can be irregular along the X, Y, and Z axes and edge lengths of different 
voxels differ along each axis. Voxels are axis-aligned rectangular bricks of different sizes.    An irregular 
grid is also referred to as a rectilinear grid.    See the Voxel Analyst Users Guide for an example of an 
irregular grid.

irregular volume
The volume that can be generated from the results of querying multiple iso-surface or bounding planes in 
a 3-D volume dataset.    For example, you can find the volume of all values greater than (>) Data Field 1, 
less than (<) Data Field 2, and bounded by a property line. 

iso-parametric
A graphic of an IJK parametric surface showing data variation in a selected volume or dataset.    Differs 
from a cutting plane in that it follows the grid lines. 

iso-solid
A graphic of a 3-D solid that represents all points in a volume between two values of a selected data field 
or characteristic. 



iso-surface
A graphic of a 3-D surface that fits through all points in a volume with a constant (equal) value for a 
selected data field or characteristic. 

keyword
A predefined mnemonic representing a parameter value.    Keywords are case-sensitive.    The 
MGVA_ASCII commands used to create MGVA_ASCII-formatted data files can accept keywords as 
input.    For example, the data_type command can accept the keywords BYTE, U_BYTE, SHORT, 
U_SHORT, INT, U_INT, FLOAT, and DOUBLE. 

levels
The display design plane consists of a multilevel display structure.    Voxel Analyst graphic displays can 
be organized in any fashion on 63 levels, although no graphic can span two levels.    Only one level can be 
active at a time, but any combination can be displayed or blanked from the screen.    The active level must 
be displayed. 

lock point
The corner of a graphic display used to determine the axis to be used to 
rotate the display or to scale the display.    The corner is identified by clicking it. 

material properties
Surface characteristics, such as reflectivity, gloss, smoothing, and transparency, of a graphic object.

MGE Modeler
An Intergraph Corporation software application that provides terrain modeling functionality for mapping 
and GIS workflows. 

MGE Terrain Analyst
An Intergraph Corporation software application that provides terrain modeling and analysis capabilities 
for geographic information systems, engineering, and resource planning organizations.    MGE Terrain 
Analyst provides GIS analysis capabilities for digital terrain models and other surface data. 

MGM
See MGE Modeler. 

MTA
See MGE Terrain Analyst. 

Next
Button on the On-line Help window that lets you move to the next Help article in the hierarchy. 

NULL
Indicates no value. 

orientation matrix
A transformation matrix (a 4 x 4 array of numbers) that positions the dataset geometry with respect to its 
design file.    The matrix represents the mathematical transformation set up through the Dataset 
positioning commands, such as Rotate Dataset and Scale Dataset. 

orthogonal view
A view in which the graphic display is constructed with right angles or perpendicular lines.    An 



orthogonal shape contains only right angles. 

PCX
An IBM graphics format file. 

pathname
The sequence of directories leading to a file. 

perspective view
A view that is a projection of the graphic display onto a plane along lines that pass through a point.    The 
eye of the viewer is assumed to be at that point. 

pitch
The angular position of a graphic object relative to the vertical axis.    For example, an object having a 
pitch of 0 degrees would appear to be at right angles with the vertical axis. 

plane
A spatial element in geometry that may or may not have a boundary, but is flat, having no curvature, and 
is three-dimensional. 

reflection coefficient
A number ranging from a minimum of zero to a maximum of one that determines the amount of 
reflectivity displayed by a graphic object.    At zero, no reflectivity is displayed.    At one, the maximum 
reflectivity is displayed. 

reflectivity
The degree to which an object is capable of reflecting light. 
regular grid --- A 3-D grid in which spacing is constant along the X, Y, and Z axes, but not equal for each 
axis; edge lengths are constant along each axis.    See the Voxel Analyst Users Guide for an example of a 
regular grid.

relative pathname
The sequence of directories leading from the current directory to a particular file.    See also pathname 
and absolute pathname. 

RGB
Red-green-blue raster display.    An RGB file has an .rgb file extension. 

RGB file format
A color file format made up of red, green, and blue data values. 

rotate
To turn; to change the angular orientation; to transform by revolution about a specific axis. 

Search
Button on the On-line Help window that lets you perform a search on a selected topic or item in Help. 

scalar data
Data represented by real numbers (rather than vectors) that have magnitude but no direction. 

scale



To enlarge or reduce the size of a defined graphic object, modifying the dimensions and the ratio among 
the components of the object. 

semi-structured grid
A 3-D grid structured only along one or two axes while regular or irregular along the other axis or axes. 

smooth shading
A method of shading a graphic object by calculating the color of the polygons at their boundaries and 
blending those colors across the polygon interiors.    See also Gouraud Shading. 

smoothing
A calculation applied to a graphic object causing the surface of the object to appear smooth. 

specular reflection
Light is reflected such that a bright spot appears on the object. This type of reflection adds definition of 
shape to the object and aids in depth perception.    Also known as highlight reflection. 

sphere
A 3-D graphic object in which all points are equidistant from a fixed center point. 

structured grid
A 3-D grid in which the X, Y, and Z coordinates for each grid node are completely arbitrary.    Voxels are 
warped bricks.    See the Voxel Analyst Users Guide for an example of a structured grid. 

surface
The skin of a 3-D graphic object. 

symbolic data
Data represented by numbers that represent discrete qualities such as lithologies, not a continuum of 
values. 

TGA file
A file formatted in the TGA File Format developed by Truevision for storing color images and 
standardized for the computer graphics industry. 

TIF file
A tagged image file. 

transformation matrix
An array of numbers used to indicate rotations, scaling, and mirroring about the X, Y, and Z axes.    
Additionally, a transformation matrix includes a translation (offset) distance in the X, Y, and Z directions. 
Matrices are used to correctly orient geometric elements in 3-D space.    See also orientation matrix. 

transparency
The quality of being transparent. 

transparent
The property of transmitting light without appreciable scattering so that an object lying underneath is 
entirely visible. 

uniform grid



A 3-D grid in which spacing along all orthogonal axes is constant and identical; all edges are the same 
length, creating cubic voxels. 

units of resolution
The smallest unit of accuracy at which a point can be located within a design area. 

UOR
See units of resolution. 

Up
Button on the On-line Help window that lets you move up a level in the Help hierarchy. 

vector data
Data possessing both magnitude and direction, generally represented as a line.    Vectors can be 
manipulated geometrically and are represented as a coordinate triple (X,Y,Z). 

void value
A numeric value assigned to null values within a grid. 

Voxel Analyst
Intergraph Corporation's software for modeling, visualizing, analyzing, and interpreting spatial 
relationships within heterogeneous data volumes. 

Voxel Analyst view
An area of vision defined by Voxel Analyst on a screen.    The X,Y plane of the view is parallel to the 
screen, while the Z-axis can be thought of as coming straight out of the view towards you.    The view 
axes maintain this relationship regardless 
of the rotation with respect to the graphic objects. 

voxel
A multi-faceted volume element or component of a 3-D volume used to reference data within the volume. 
In Voxel Analyst, a voxel can also be referenced to geographic coordinates.    A simple example of a voxel 
is a cube in which each face is square.    In a more complex voxel, each face can have a different size and 
shape.    See the Voxel Analyst Users Guide for more information.

wireframe
A representation of a 3-D graphic as line segments outlining its surface.

XYZ 
Three-dimensional geographic coordinates. 

yaw
The angle of rotation of a graphic object about the vertical axis relative to a fixed horizontal reference 
direction. 

zoom
Decrease (zoom in) or increase (zoom out) the portion of the object displayed in a view. 






